






























































































































































































































































































































































































































































































































































































































































































Automatic Internetlets you connect to the Internet by configuring your connection 
information in a matter of minutes. 

• If you do not yet have an Internet account, you can choose an Internet Service 
Provider and sign up for an account online. When you sign up for your account, 
your software is automatically configured with the appropriate connection 
information. 

• If you already have an Internet account (or if you have been given a Provider 
Identification Number), you can use the Automatic Internet application to register 
your existing account with NetManage. If your Internet Service Provider has filed a 
configuration for their service with NetManage, your software will be automatically 
configured with the appropriate connection information. This automatic 
configuration includes the setup of the Mail server, the NEWTNews server, and the 
Web server. 

• If your Internet Service Provider has not filed a configuration with N etManage or if 
you do not have a Provider Identification Number, you can still use the NetManage 
tab portion of Automatic Internet application to automatically configure some of the 
Custom information. However, your configuration will not include setup of a Mail 
server, NEWTNews server, or Web server. 

Choosing and Signing Up for a New Internet Access 
Account 
Use Automatic Internet to choose and sign up for an account with an Internet Service 
Provider, as follows: 

1. Open the Automatic Internet application by double-clicking on the icon in the 
program group. A dialog box appears that includes tabs for several Internet service 
providers, and a tab for NetManage. 

Note: NetManage is not an Internet Service Provider. 
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2. Select one of the Internet Service Provider tabs and then choose the More Info 
button. 

The Provider's More Info dialog displays information on contacts, service, and 
pricing. Some providers offer free demonstration accounts. Read the information 
displayed by the More Info button for each provider to find out if they offer demos. 
Once the time has expired on your demo, you must use Automatic Internet again to 
sign up for a permanent account. Demos are limited to one per person. Call the 
Provider directly if you have additional questions about local access availability or 
pricing. 

The tab dialog of NetManage provides introductory information on the Automatic 
Internet application and explains the registration process. NetManage is not a 
provider. 

3. To sign up for an account with a Provider, select the tab of the Provider that you 
want to use and then choose the Signup button. 

Note: Automatic Internet uses a secure phone call to communicate with the registration 
server. Your credit card number will not be sent over the Internet. 

332 

Most of the time, you need a credit card to sign up for a Provider account using 
Automatic Internet. If you do not have a credit card, call the Provider directly for 
information. 

You will be presented with various connection options and prices when you actually 
connect with the provider's server. You will have an option to cancel the sign-up 
process after you have connected with a registration server. 

An Automatic Internet Account Sign Up dialog box similar to the following figure 
appears. This is where you enter your personal registration information to send to 
the provider. 
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4. Type your name, address, and phone numbers in the appropriate fields. Enter your 
name and address as it appears on your credit card. You can enter information in 
the StatelProvince and Country fields by either selecting or typing it. 

5. Select the type of credit card to which you want to charge the Internet services, and 
type that card's number and expiration date. You must enter the expiration date 
using the following format: mm/yy. 

6. Depending on the Service Provider you choose, there mayor may not be additional 
tabs to supply additional information the provider is requesting at signup. Select 
these tabs if they are present and supply the requested information. 

Note: If you forget to select the second tab, Automatic Internet will prompt you to select 
the tab and fill out the additional information. 

7. Choose the Phone List button to select the phone number to be used for sending in 
your registration information. Choose the one most local to you. You may edit this 
number to add special dialing prefixes (such as 9) if required by your phone system. 

Note: This is not the number you use to call your provider for connecting to the 
Internet.. This is the number of the registration server. You will not be 
communicating your registration information over the Internet. That number 
will be downloaded from the provider upon sign-up. 

8. Choose the Send button to sign up for your account. Once you choose the Send 
button, the status area on the lower right will indicate the progress of your 
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connectiori and sign up. The traffic lights signal the flow of the registration data 
from your computer through the phone line to the provider's server and back. 
Accompanying status messages are displayed in the text box located below the 
traffic lights. 

Note: Registration servers may be busy at times. Please try registering again later. If a 
problem occurs during registration that prevents the registration process from 
completing, the Send button is replaced by a Resend button. In this situation, 
recheck your information and choose the Resend button. 

9. Choose the Advanced button only if you need to specify a different communications 
port. The Automatic Internet application will automatically sense your modem on 
the appropriate COM port. If your modem does not initialize correctly, please 
verify the COM setting by selecting the Advanced button and choosing the correct 
COM port. By default, the first available COM port will be chosen. 

In a few minutes, the provider's server will send back your personalized account 
information and automatically configure your software. An interface will be created 
for Custom that defines how Internet Chameleon connects to your Provider. This 
includes your username, password and dialup number. Automatic Internet will also 
create a mail account for you and set WebS urfer, NEWTNews and Gopher defaults 
according to your Provider's specifications. A welcome message from your 
Provider will be displayed and you are now ready to explore the Internet. 

10. Reboot your system, then open the Custom application and select Connect to 
connect to the Internet. 

11. Minimize Custom and begin using the applications. 

Automatically Configuring Connection Options for an 
Existing Internet Account 
You can use Automatic Internet to register and automatically configure the connection 
options for an existing Internet account, as follows: 

1. Open the Automatic Internet application by double-clicking on the icon. 

2. Select the NetManage tab and choose the More Info button for information about 
the Automatic Internet application and the registration process. 

3. Choose the Sign Up button to register your existing account with NetManage. 

Note: You do not need to fill out the credit card information if you are simply 
registering an existing account with NetManage. 
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4. Fill out the two registration forms as completely as possible. Your provider should 
have given you information needed to fill out the second registration form when you 
signed up for an account. 

Provider identification number: A unique number for each provider assigned by 
NetManage, and given to the user by the Provider. This field is optional. If your 
provider does not have one, leave this blank. If you do specify an appropriate 
Provider identification number, your automatic configuration includes the setup of 
the Mail server, the NEWTNews server, the Gopher server, and the Web server. 

User account name and password: Uniquely assigned to you by your provider. 
Your account name and password allows you to access the Internet through your 
provider. 

Your IP address: A unique number assigned to you by your provider. If your 
Provider uses dynamic IP assignment (that is, you get a different IP address 
assigned to you each time you connect). fill the IP address field with a "dummy" 
address. For SLIP/CSLIP accounts, use" 1 . 1 . 1 . 1" and for PPP accounts, use 
"0.0.0.0." 

Mail account name and password: Uniquely assigned to you by your provider. 
Your mail account name and password allows you to send mail through the 
Internet. 

Type of account: Choose from one of the following: PPP, SLIP, CSLIP, ISDN. 
Your provider will notify you of your account type. 

5. When you have finished filling out the form(s) completely, hit the Send button. 
Select "configuration only" and click OK to continue with the registration process. 
Automatic Internet will configure your PC for an Internet connection. 

You may receive a message that your provider has not filed a configuration for their 
service with NetManage. In this case, you will need to open Custom and complete 
the configuration. Do this by filling in the domain name, dial (access phone 
number), and domain name server in the Setup menu. Do a Save in the File menu, 
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exit Custom and restart Windows. Reopen the Custom application and select 
Connect. Minimize Custom and begin using the applications. 

Follow the instructions in the manual to set up your mail gateway, mail server, 
(NNTP) news server and connection script. 

Verifying or Modifying Your Automatic Internet 
Configuration 
The first time after you run Automatic Internet, you should verify the settings for port, 
modem, and Dial under Setup in the Custom application. If you are using an ISDN card 
that supports direct interface with the card via the WinISDN standard, and if your 
provider has downloaded an ISDN interface, you will need to select the Hardware Type 
in the Setup menu. You need to verify these settings only once. Use Automatic Internet 
only once to sign up for each account. 

Caution: Creating a second account from a new provider will overwrite the domain 
name server, Mail server and gateway, NNTP News Server, and World Wide 
Web default home page. Therefore, before creating a second account, you 
should write down these settings or backup the *.CFG files. 

Connecting to the Internet 
You use Custom to initiate your dial-up Internet connection. After verifying your 
settings, simply select Connect from the Custom menu. 

Troubleshooting 
o Be sure to fill out all the input fields before you send your registration information 

in. An account application must be completely filled out in order to be accepted by 
the provider. 

o Enter your name as it appears on your credit card. 

o If the provider's server takes too long to respond, your connection will be timed out. 
Try to send your registration information later, or increase the Timeout before 
Disconnecting option in the Custom application (use the Setup menu, 
Communications command, Dial option). 

See Automatic Internet Online Help for additional Troubleshooting Tips. 
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The NEWTSound application enables you to run a sound file. Supported sound file 
extensions are as follows: 

• .WAV 

• .AU 

• .VOC 

• .SND 

• .IFF 

When you open the application, a NEWTSound File dialog box is displayed, allowing 
you to select a directory and a sound file. 

Note: You must also have a sound board or a sound-board emulator installed in your 
computer to use this application. 

The NEWTSound application does not contain any additional menus. However, the 
NEWTSound File dialog box does contain a few buttons. When you choose the 
Associate button, the NEWTSound Association dialog box is displayed. 

The NEWTSound Association dialog box contains a list of currently supported file 
extensions. Select whichever file extension(s) you want to associate with the 
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NEWTSound application. This option allows you to play sound files with that extension 
by selecting them from the File Manager. You can also play an associated sound file by 
dragging and dropping the sound file onto the NEWTSound application. 

Associating the file with NEWTSound will override any previous file associations with 
that file extension. 

Troubleshooting 
If you experience difficulties using the NEWTSound application, refer to the following 
items: 

o Verify that you have specified an Association for the file you are trying to open. 

o Verify that the file you are trying to open is not corrupted. Check the file listing in 
the File Manager. If the file is listed as having "0" bytes, it is a corrupted file. 
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The Ping application is a network diagnostic tool used to verify connectivity to a 
particular system on your network. The Ping application transmits any number of echo 
requests to a particular system and displays the results for each echo reply. This 
exchange is referred to as pinging. These echo requests and replies are supported by all 
systems on the network, including those that are currently running one or more 
Chameleon applications. This is accomplished through the use of the Internet Control 
Message Protocol (lCMP). If you encounter a problem in an application, pinging 
determines if the problem is with the application or due to a non-responding host. You 
may have multiple instances of the Ping application active simultaneously. 

The current options and host name can be saved to a configuration file named 
PING.CFG (default). The configuration file is loaded when the Ping application is 
started. If a host name or IP address is specified, the Ping application immediately 
begins pinging that host. You can also supply a command line option to specify the host 
name or IP address. 

Ping Host 
To request a particular system to ping do the following: 

1. Select Start. The Host dialog box appears. 

2. Type or select a host name or IP address in the Host dialog box. 

3. Choose the OK button. The application sends an echo request and waits for the 
echo reply. If no reply is received within the timeout value (default is 6 seconds), 
the ping fails. 

A single ping produces summary lines in the Ping window. Multiple iterations or 
continuous pinging produces a single summary line for each ping. After each ping, 
summary lines are generated, giving the total statistics for this sequence of pings. 

Note: When minimized an animated icon of a ping-pong ball indicates active pinging. 
The ball moving back and forth indicates successful pings. 

file Settin s !:!el 
64 bytes cmp_seq=6, 659 ms 
64 bytes received, icmp_seq=7, time=1044 ms 
64 bytes received, icmp_seq=8, time=1263 ms 
64 bytes received, icmp_seq=9, time=1153 ms 
64 bytes received, icmp_seq=10, time=1098 ms 
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Ping Settings 
The Ping Settings menu allows you to access the Preferences dialog box and the Auto 
Start option. 

The Preferences dialog box contains the following options: 

Iteration: Specify the number of echo requests to transmit (1 through 9999 seconds), or 
for an infinite number of interationsselect Continuous. 

Data Length: Specify the length of each echo request (0 through 1,400 bytes). The 
default is 64 bytes. 

Interval: Specify the time the application waits for a response to the ICMP _ECHO 
request sent (1 through 999 seconds). If there is no response after the specified time the 
ping returns "0 bytes received". 

Timeout: Specify the timeout value for the echo reply (1 through 999 seconds). 

To automatically start Ping through your Windows application do the following: 

1. Choose the Auto Start option from the Preferences menu. 

2. Choose Run from the Program Manager's File menu and type the following 
command line: 

ping<system name> 

Troubleshooting 
If you experience difficulties using the Ping application, refer to the following items: 

o Verify that the installation and setup steps have been successfully completed. 

o Try to Ping by using the IP address (instead of Host name) to determine if there is a 
name resolving problem. 

o The network portion of the IP address must be a locally connected interface, or a 
default gateway must have been specified to route unknown networks. 

o A local host table or domain server must be specified when pinging by host name. 
The host name entry must specify the correct IP address. 

o For a vVindows system, the NEWT application must be running for Chameleon to 
respond to an echo request. 

o Make sure that the Ethernet type is correct: it should be EthernetlDIX in almost all 
cases. 

o Verify that there is a valid Frequent Destinations entry for this IP address. 
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To use finger, do the following: 

1. Choose the Finger icon, to display the Finger dialog box. 

2. Select or type the desired host in the Host field. 

3. Type the desired user name in the User field. 

If a user name is not specified in the User field, Finger displays information on all 
the users currently logged in to the specified host. 

4. Choose the Finger button. 

Eile JOdit lieHlngs Help 

--- Host: netmanage. co. il User: shani 

Login name: shani In real 1 if e: Shani Kleinberger 
Directory: /net/nmi/shani Shell: /bin/csh 
Last login Tue Dec 6 16'.09 on ttyp5 from shani.netmanage. 
No unread mail 
No Plan 

Verbose Option 
Choose the Verbose option from the Settings menu. 

Verbose displays information provided by the Finger application for each user logged on 
to the specified host. This information includes: 

• login name 

• full name 

• home directory 

• login shell 

• time of login (if user is currently logged in) 

• time of last login (if user is not currently logged in) 

• terminal or host from which the user logged in 
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• last time the user received and read mail, and idle time 

• information of any plan contained in the file .plan and any project described in the 
file .project, both are located in the user's home directory 

By default, Finger displays one line of information per user including login name, user 
name, TTY, idle time, time of login, and terminal or host from which the user logged 
in. 

Troubleshooting 
If you experience difficulties using the Finger application, refer to the following items: 

o Verify that the installation and setup steps have been successfully completed. 

o Use the Diagnose Connection from the Help menu to start Ping and verify 
connectivity to any remote system to which you want access. 

o Verify that the host entered is a valid Finger server. 
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The Whois application is a TCPIIP Internet user name directory service that displays 
information about Internet users who are listed in that directory. 

For example: 

Clark, Shawn (SCI78) sclark@SENCO.COM (513) 333-232 

Information about a user includes: 

• full name - for example Clark, Shawn 

• handle - a unique identifier, in parenthesis. For individuals the handle is composed 
of the person's initials and where necessary a trailing number - for example 
(SC178). 

• network mailbox for Defense Data Network (DON) users (who are registered in the 
Network Information Center (NIC) database) - for example sclark@SENCO.COM 

• telephone number - for example (513) 333-232 

• U.S. mailing address 

Using Whois 
The Host field contains the hostname of a Whois Server. The default server is 
rs.internic.net. You can search the Whois directory on a different server by selecting or 
typing the hostname of another Whois server in this field. 

Note: To view a list of Internet Whois servers, select Whois Servers List option from 
the online Help Contents menu. A list of Internet Whois servers is also available 
via anonymous FTP to sipb.mit.edu, in the pub/whois directory. 

To start a search: 

1. Type or select the name of an alternative Whois server or use the default server. 

2. Type the username or text you wish to search for in the User field. 
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3. Choose the Whois button to start the search. 

Search Options 
Whois allows you to perform a comprehensive search or a more specific search. In 
general, searches are conducted in the way outlined below, but this may vary between 
Whois servers. Most Whois servers provide their own help files. 

• General search: If you specify a string of alpha characters, Whois searches for a 
name, handle, or mailbox matching that string. For example, if you specify 
"Smith" in the user field, Whois searches for the name Smith, the handle (Smith) 
and the mailbox Smith @. 

• Name-only search: Precede the name with a period. For example, if you specify 
".Smith, Jane" in the user field, Whois searches only for the name Jane Smith (not 
for the handle or mailbox). 

• Handle only search: Precede the handle with an exclamation point. For example, if 
you specify" !Smith" in the user field, Whois searches only for handle Smith, such 
as Smith College (Smith) 

• Mailbox only search: Type the @ character after the name. For example, if you 
specify "Smith@" Whois searches for the mailbox Smith only, such as Smith@ 
CVR.COM 

• Group or organization entry search: Type an asterisk as the first character. For 
example, if you specify *SRI-NIC, Whois searches for all users in that group entry. 

• Partial search, to find all entries starting with specific text: After the text you want 
to search for type a dot or trail of dots. For example Robert... looks for all names 
preceding with the letters ROBERT, such as Robert, Roberts, Robertson. 

Note: If there are a large number of members, it will take longer for the list to display. 
The Whois button remains dimmed until the full list is displayed. 

If the User field is blank and the Whois button clicked, any Help or information files 
available from the directory specified in the Host field are displayed. 

Troubleshooting 
If you experience difficulties using the Whois application, refer to the following items: 

o Verify that the installation and setup steps have been successfully completed. 

o Use the Diagnose Connection option from the Help menu to verify connectivity to 
any remote system to which you want access. 

o Verify that the Host is a Whois server. Note that not all Internet Hosts are Whois 
servers. Chameleon Whois provides the major Internet Whois server 
(rs.internic.net) in the Hosts drop-down list by default. A list of Internet Whois 
servers is available via anonymous FTP to sipb.mit.edu, in the pub/whois directory. 
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Alternatively, select the Whois Server list option from the online Help Contents 
menu option. 
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The Bind application provides name server functions as a Domain Name Server (DNS). 
You can specify multiple domains and a list of host names within each domain. Bind 
provides hostnames to IP address resolution according to the DNS protocol. DNS is 
used to administer host and domain names from a central location, which is simpler 
than maintaining a hosts file on each network host 

Name Server Setup 
To specify a Domain, choose the Add button and type in the name of a domain (for 
example, netmanage.com) and choose the OK button. Choose the Save button at any 
time to save changes to the list of domains and any hosts defined for each domain. The 
saved information is in a standard format as a collection of files for each domain. 

To add host definitions to a domain, select the domain and choose the Modify button. A 
dialog box appears with the domain name as the caption. You may add, modify, or 
delete individual host definitions. Choose the OK button when finished. 

By choosing the Add or Modify button, a dialog box appears in which you can type the 
name of the host and it's IP address. The name should not specify the full domain. For 
example, defining a host named howard resolves requests for both howard and 
howard.netmanage.com. 
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Troubleshooting 
If you experience difficulties using the Bind application, refer to the following items: 

o Verify that the installation and setup steps have been successfully completed. 

o The Bind application must be running to respond to name server requests. You can 
place a copy of Bind in your Startup group to ensure this. You may run Bind 
minimized, as an icon. 

o Verify that the domain server IP address is entered correctly in the system 
originating the name lookup request. 

o Verify that the domain name and host name definitions are entered correctly in the 
Bind application. 
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PC NetTime is a client/server application that allows you to synchronize the time 
between your PC and any time server. As a client, you can use PC NetTime to 
automatically synchronize your PC's time with the server, or to update the time 
manually by selecting the update button. You can also set your preferences so that your 
PC N etTime will act as a server with which other PC N etTime clients can synchronize 
their PC's time. 

Setting Up PC NetTime 
To set up PC NetTime, take the following steps: 

1. Choose the PC NetTime icon. A PC NetTime window similar to the following 
figure appears: 

2. Select Preferences ... from the Settings menu. A Preference dialog box similar to the 
following figure appears: 
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3. Select the desired options in the dialog box. The options are as follows: 

Current Location: Specify the time zone where your PC is located. Using the drop­
down list box, you can select the time zone according to its geographical area or its 
relationship to GMT (Greenwich Mean Time). 

Host: Type or select the name of the time server with which you are synchronizing 
the time of your PC. 

Port: Type or select the time server's port number. The default port is 37 (as 
defined in RFC 868). 

Host Location: Specify the time zone where your host is located. Using the drop­
down list box, you can select the time zone according to its geographical area or its 
relationship to GMT (Greenwich Mean Time). 

Exit after Update: When you start PC NetTime it automatically updates or 
synchronizes the time of your PC with the specified host. Select the check box for 
the application to automatically exit after the update is completed. 

Listen on port: Enables Time Services, which allows your PC to act as a server to 
PC NetTime clients. Other PC NetTime users can identify your PC as the host for 
synchronizing the time of their PCs. 

Port number: Select or type the time server's port number that should be listened to 
for incoming time requests (if Time Services is enabled.) 

4. When you have finished selecting the desired options, choose the OK button. 

Updating and Getting Local and Host Times 
You can easily update the local time or get the host time by using the Commands menu 
options or the Update and Get buttons. You should do this after making any changes in 
the Preferences dialog box. 

Changing Between Analog Clock/Digital Clock 
To change the clock's screen display choose AnaloglDigital clock from the Settings 
menu. 

Changing the Default Time Zones 
An advanced user can create another timezone.ini file by copying and renaming the 
default file, then editing it to include the additional country and time zone. Each listed 
country is followed by the time difference from GMT. To expand the list, add the 
country and time difference in the same format. For example: 

Hongkong=GMT+08:00 

To change the default time zone file used: 
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1. Select the Time Zone ... option from the File menu. 

2. Select the desired file with the needed time zone specifications. 

3. Choose the OK button. 

Automatic Startup 
Select the Run at Startup option from the Settings menu if you want the PC NetTime 
application to start automatically when Windows is started. 

Troubleshooting 
If you experience difficulties using the PC NetTime application, refer to the following 
items: 

o Use the Diagnose Connection option from the Help menu to verify connectivity to 
. any remote system to which you want access. 

o Verify that the correct time zone has been set. 

o . Verify that a valid host is selected. 

o Verify the time on the selected host. 

o Verify the time zone of the selected host. 
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The Name Resolver application enables you easily to retrieve the IP address of a known 
host or the hostname of an IP address. 

To find the IP address of a host, enter the host name in the IP Address or Hostname field 
and choose the Lookup button or press the Enter key. 

To find the hostname of an IP address, enter the IP address in the IP Address or 
Hostname field and choose the Lookup button or press the Enter key. 

If Name Resolver is able to locate what you are looking for, both IP address and host 
name are displayed. Otherwise, it will display a message stating why the host name or 
IP address cannot be found. 

Troubleshooting 
If you experience difficulties using the Name Resolver application, refer to the following 
items: 

o Make sure that the installation and setup verification steps have been successfully 
completed. 

Use the Ping application to verify connectivity to any remote system to which you want 
access. 
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The NISLookup application, which uses the Network Information Service (NIS) 
protocol, displays information retrieved from NIS including map entries, domain and 
server names. 

NIS maintains centralized network administrative information in tables or maps. You 
can select a map name from the map list or enter the name manually. Some of the more 
common NIS map names, such as host and password maps, are included in the list. 

NIS domains consist of NIS clients and servers sharing common information. NIS 
clients request information from a domain, rather than from a server, thereby allowing 
dynamic server configuration completely transparent to the clients. 

Key: t1 Map: hasts.byname 

156.27.1.1 t1 

Map: hosts. byname ---

156.27.3.1 t3 
156.27.1.1 t1 

Looking Up Map Entries 
To look up an NIS map entry, you must specify the map name in the Map field and key 
name in the Key field and choose the Lookup button. The corresponding map entry is 
then retrieved from NIS and displayed in the display window. For example, a host 
name and IP address can be retrieved. 

Retrieving Entire NIS Maps 
To retrieve an entire NIS map, specify the map name in the Map field and choose the 
Retrieve button. The entire map is retrieved from NIS and displayed in the display 
window. For example, you can retrieve a host map. 

Retrieving NIS Domain Names 
To retrieve the NIS domain name, select the Domain option from the Settings menu. 
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To configure the NIS domain name, use the Custom application. Refer to the chapter 
titled, Customizing Your Setup, in this manual for additional information on 
configuring the NIS client. 

Retrieving the Domain NIS Server Name 
You can retrieve the NIS server name for the domain by selecting the Server option from 
the Settings menu. Although a NIS domain may contain multiple NIS servers, only one 
server, the first to respond, is used. 

Troubleshooting 
If you experience difficulties using the NISLookup application, refer to the following 
items: 

o Verify that the installation and setup verification steps have been successfully 
completed. 

o Verify that an NIS domain has been specified in Custom. Contact your System 
Administrator for the NIS domain name. From a UNIX host, the domain name can 
be retrieved using the domain name command. 

o Verify that an NIS server is serving the specified NIS domain. From a UNIX host, 
you can retrieve the server using the ypwhich command. The Portmapper 
application can be used to determine if the ypserv program is running on the NIS 
server. 

o Verify communication with the NIS server using the Ping application. 

o Verify that the NIS server resides on the same sub net as this machine. 
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The R-Commands application lets you enter and execute the rcp (remote copy) and rsh 
(remote shell) UNIX commands in a Windows environment: 

• rcp (remote copy) is a network version of the UNIX cp command. Use this 
command to copy files from one computer to another system on the network. 

• rsh (remote shell) is a network version of the UNIX sh command. Use this 
command to establish a connection to a remote UNIX system and then execute a 
command on that system. 

Both the rcp and the rsh commands eliminate the need to first log in to a remote system. 
Passwords are also bypassed, by creating "trusted" Hosts or User names, avoiding the 
need to send passwords over a network. Therefore, you may find these commands more 
convenient to use than the standard UNIX cp and sh commands. 

The commands you enter can be executed immediately or saved for later use. Save 
commands if you want to add them to a Command Profile or execute them later. 
Similar to a batch file, a Command Profile is a series of rcp and rsh commands that are 
executed one after the other. Like the commands, a Command Profile can be executed 
immediately or saved and then executed later. 

Setting Up R-Commands 
Note: "Local user" refers to the user entering the R-commands. 

"Remote user" refers to the user connected to the UNIX system where the 
command will be executed. 

Entries in UNIX /etc/hosts.equiv and.rhosts files determine whether the Local user is 
permitted to access a Remote user's login account. These files define all Local user 
names and their host (machine) names that are allowed to access the remote login 
account. You may edit these files. They are plain text files with the entries in the 
following format: 

hostname <space> username 
hostname <space> username 

Where -

"hostname" is the name of the UNIX or PC Host from which the rcp/rsh will be 
performed 

"username" is the Local user, who is granted the right to access this accountls and 
to perform any rcp/rsh commands using this account. 
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Adding an entry into the UNIX /etc/hosts.equiv file allows the Local user access to all 
login accounts on that host. 

Adding an entry into the .rhosts file allows the Local user access only to this specific 
account. The file, belongs to the Remote user's login account and resides in the user's 
home directory, with the other "." (dot) files. The owner of the specific login account 
may need to create the .rhosts file. 

If the Local user's name does not appear in either of these files, access to the remote 
login account will be denied. 

To set up R -Commands, do the following: 

1. Choose the R -Commands icon. 

2. Choose Preferences ... from the Settings menu. A Preferences dialog box similar to 
the following appears: 

3. In the U serN arne field, type your user name. 

4. In the Working dir field, specify the directory from which you want to take and/or 
place files. Choose the Working dir button to browse through the directories. 

5. If desired, specify one or both of the Confirm On options: 

• Select the File Replace option to confirm when a file replaces an existing local 
file. 

• Select the List box selection delete option to confirm the deletion of a command 
in the command list selection region. 

358 ChameleonNFS Installation and User's Guide 



By default both the Confirm On options are selected. 

6. Choose the OK button. 

Entering rep Commands 
The rcp command lets you copy files or directories between two systems on the network. 
Use the rcp command to copy files or directories from: 

• your local computer to a remote system 

• a remote system to your local computer 

• one remote system to another remote system 

To enter an rcp command, do the following: 

1. Choose the Build ... option from the Commands menu. 

2. Choose the RCP tab. A dialog box similar to the following appears: 

3. In the Description field, type a name for the command you are entering. 

4. Select a direction from the Transfer direction file drop-down list. 

The Transfer direction selection determines which fields (From and To) must be 
specified: 

• local to remote transfer: specify only the To fields 

• remote to local transfer: specify only the From fields 

• remote to remote transfer: specify both sets of fields 

5. To define the From field, do the following: 

• In the From Name field, select or type your usemame for the machine from 
which you plan to copy the file. 

The UserName you entered when setting up R-Commands is listed in the 
drop-down list. 
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• In the From Host field, select or type the name of the host on which the file or 
directory you want to copy resides. 

If you plan to copy a file or directory from a remote system, include a 
backslash (\), quotation mark (") or apostrophe (') in the remote host's 
pathname. This ensures the metacharacters of the remote system are 
interpreted remotely. 

• In the From File field, enter the name of the file or directory you want to copy 

For a local PC, the machine on which your working directory is located is 
the default. You specify your working directory as discussed in "Setting 
Up R-Commands." 

6. To define the To field: 

• In the To Name field, type the usemame assigned to you on the host to which 
you want to copy the file or directory. 

• In the To Host field, select or type the name of the host to which you want to 
copy the file or directory. 

Note: If you plan to copy a file or directory to a remote system, include a backslash 
(\), quotation mark (") or apostrophe C) in the remote host's pathname. This 
ensures the metacharacters of the remote system are interpreted remotely. 

• In the To File field, enter the file or directory to which you want to copy. 

For local connection you can choose the browse button to help you locate 
and select the desired file. 

7. If desired, specify either or both of the rcp command options. 

• Select the -r (copy each subtree) check box to copy any subdirectories rooted at 
the directory of the original file. 

• Select the -p (attributes) check box to assign the original file's modification 
time, access time and modes to the duplicate file. 

8. Choose the OK button to save the command to the commands list so that later you 
can execute it or add it to a Command Profile. 

9. Choose the Run button to execute the command immediately without saving it to 
the commands list. 

Entering rsh Commands 
The rsh command establishes a remote host connection and executes a specified UNIX 
command or a batch file containing multiple UNIX commands. Output from rsh is 
displayed in the R-Commands window's output region unless you redirect the output to a 
file. 
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To enter an rsh command, do the following: 

1. Choose the Build ... option from the Commands menu. 

2. Choose the RSH tab. A dialog box similar to the following appears: 

3. In the Description field, type a name for the command you are entering. 

4. In the Shell command field, type the UNIX command you plan to execute on the 
remote host. For example, the Is UNIX command lists directories. For details on 
UNIX commands, see your UNIX documentation. 

The From Name, Host and File fields are inapplicable, and therefore dimmed. 

5. In the To Name field, type the username assigned to you on the host to which you 
want to establish a connection. 

In the To Host field, select or type the name of the remote host to which you want to 
establish a connection. 

Type the file's complete pathname in the Output field to send output to a file rather 
than display it in the R-Commands window's output region. Select the local path 
check box to send an output to a local file. Selecting the local path check box 
enables the browse button, to help you locate and select the file. 

6. If you redirect output to an existing file and want to overwrite that file's contents, 
select the rewrite an existing file check box. 

Note: If the rsh command causes conflicts between rsh and the shell on the remote 
host, select the -n option. This redirects the input of rsh to !dev/null. 

7. Choose the OK button to save the command to the commands list, so that later you 
can execute it or add it to a Command Profile. 

8. Choose the Run button to execute the command immediately without saving it to 
the commands list. 
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Creating Command Profiles 
Command Profiles, which are similar to batch files, contain a set of rcp and rsh 
commands that are executed in a series. Create a Command Profile using the rcp and 
rsh commands that were previously saved to the commands list. 

You can execute a Command Profile immediately after you create it, or you can save it 
to the commands list, in the main window, and execute it later. The commands are 
executed in the order they are listed in the profile. 

To create a Command Profile, do the following: 

1. Choose the Build ... option from the Commands menu. 

2. Choose the Profile tab. A dialog box similar to the following appears. 

3. In the Description field, type a name for the Command Profile you are creating. 

4. Add commands to the Profile commands box in the order in which you want them 
executed. To do so, select a command in the List of commands box and a command 
in the Profile commands box. Then do one of the following: 

• Choose the Before button to add the command before the one currently selected 
in the Profile commands box. 

• Choose the After button to add the command after the one currently selected in 
the Profile commands box. 

You can delete a command from the profile by selecting the command in the Profile 
commands box and then choosing the Delete button. 

5. After you have added all desired commands to the profile, perform one of the 
following operations: 

• Choose the OK button to save the profile to the commands list so you can 
execute it later. 

• Choose the Run button to execute the profile immediately without saving it to 
the commands list. 
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The bottom status bar displays details about the highlighted command. 

Executing Commands List Items 
To execute commands or Command Profiles previously saved to the commands list do 
the following: 

1. Select the desired command or profile from the R-Commands window's commands 
list. 
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2. Choose the Run button, or double click the command. 

An executed command or Command Profile's output is displayed in the output region of 
the R-Commands window. You can copy this information to another application, delete 
it or print it. 

To copy the information to the clipboard, select it and choose the Copy option from the 
Edit menu. You can then copy the information from the clipboard to another 
application. 

To delete the information displayed in the output region, choose the Clear Buffer option 
from the Edit menu. 

To print the information, select it and then choose the Print... option from the File 
menu. 

Modifying Commands or Command Profiles 
You can modify a command or Command Profile by performing either of the following 
operations: 

• Select a command and edit it in the Command field of the R-Commands window. 

• Select it from the commands list and then choose the Modify ... option from the 
Commands menu. A Modify dialog box appears. This dialog box contains the 
same fields as the Build dialog boxes. For details on a command or profile's fields, 
see the previous section in this chapter that discusses that command or profile. 
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Deleting Commands or Command Profiles 
To delete a command or Command Profile from the R-Commands window's commands 
list do the following: 

1. Select the command or profile from the commands list. 

2. Select the Delete option from the Commands menu. 

Stopping Command Profiles 
You can stop a Command Profile while it is running. 

To stop a Command Profile while it is running select the Abort option from the 
Commands menu. 

Troubleshooting 
If you experience difficulties using the R-Commands application, refer to the following 
items: 

o Verify that the installation and setup steps have been successfully completed. 

o Use the Diagnose Connection option in the Help menu to verify connectivity to any 
remote system to which you want access if a failure to connect is reported. 

o Interactive programs such as word processors and spread sheet programs should 
not be run in R shell. 

o Make sure you only copy individual files and not entire directories from Local to 
Remote Hosts (including use of the -r or *. * commands). 
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When you use any Chameleon application, an icon representing the NEWT TCPIIP 
kernel appears on the screen. The NEWT application permits you to view information 
about the current network interfaces. The NEWT application must be running for 
network connectivity to be enabled. It cannot be terminated explicitly, but exits 
automatically when the last Chameleon application exits. NEWT provides information 
through a set of dialog boxes which you can display by choosing the NEWT icon. 

Note: You can minimize the NEWT application with many open dialog boxes and it 
will minimize all the dialog boxes as well. When the NEWT application is 
restored, all dialog boxes reappear as they were prior to being mini;ruzed. 

Network Statistics 
The Statistics menu consists of selections for all network protocol layers (Interface, 
ARP, IP, ICMP, UDP, TCP and SNMP). The following tables describes the type of 
statistics each protocol level displays. 

Protocol Types of Statistics 

Interface Ethernet board statistics 

ARP Address lookup statistics 

IP IP address statistics 

ICMP IP management protocol statistics 

UDP Datagram statistics 
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Protocol Types of Statistics 

TCP Connection oriented statistics 

SNMP Network Management protocol 
statistics 

The Interface statistics are displayed for the currently selected interface. Double­
clicking on a particular interface entry also displays the Interface statistics dialog box. 

Each menu selection displays a dialog box with statistic values for that protocol. Each 
of these dialog boxes can be set to update values every second, by pressing the Start 
button. Further updates can be prevented by pressing the Stop button (which appears 
after you have pressed the Start button). The Reset button can be used at any time to 
reset the statistics values to zero for that window. 

Network Tables 
The Tables menu consists of selections for all network protocol tables (ARP, route, 
socket, Gateway and DNS, and SNMP). 

• The ARP table displays the current mapping of IP addresses to physical addresses 
and any defined Frequent Destinations. 

• The Route table displays the current set of route entries corresponding to all local 
interfaces, static route entries, and the default gateway, if specified. 

• The Socket table displays the currently open sockets, as well as their connections 
and states. There is always at least one socket entry used by the NEWT application. 

• The Gateway and DNS table provides a view of the current default gateway, as well 
as the DNS (Domain Name Server) IP addresses. The default gateway specifies the 
machine that will accept and route packets destined for other networks. The IP 
address of a DNS and up to two alternatives may be specified. 

• The SNMP table provides a view of currently active agents with their corresponding 
Enterprise ID. The Enterprise ID is a unique identification number given by the 
Internet registration to organizations who request an ID for purposes of defining 
SNMP MIBs. This is done to ensure the uniqueness of all managed objects for 
SNMP. NetManage's Enterprise ID is 233. 

USing the SNMP Protocol 
SNMP is the Simple Network Management Protocol that allows TCPIIP Managers to 
manage Agents over the network. 

ChameleonNFS offers an extensible SNMP agents that greatly extend the capabilities of 
SNMP-based management applications. SNMP is a standard feature of ChameleonNFS 
and requires no additional base memory space. 
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Several SNMP agents are provided with ChameleonNFS. The main MIB agent 
(Management Information Base) is known as MIB-II, which is the industry standard for 
managing the TCPIIP protocol suite. In addition, ChameleonNFS includes an enterprise 
MIB for managing Windows desktops. For example, this NetManage MIB can provide 
information about DOS and Windows versions or about software currently running on 
the workstation. Additional agents written by NetManage or other developers can be 
registered with SNMPD and easily become part of your managed PC. 

Setting UP SNMP 

When you use the SNMP for the first time, you need to enter the following: 

• Host administration information 

• Trap information 

• Community setting information 

This information will be available to management systems that support MIB-II. 

Host Administration Information 

In order to personalize your workstation, you need to enter information that describes it. 
This information is part of the "system" group of MIB-II, and includes the following: 

• your name 

• administrative contact regarding this workstation 

• location where the workstation resides 

To enter the host administration information, do the following: 

1. Choose the NEWT icon. 

2. Choose the Host Administration ... command from the SNMP menu .. 

3. Enter your name, the name of an administrative contact for this workstation, and 
the location where the workstation resides. 

4. If desired, select the Generate Traps option, and choose the OK button. 
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Trusted Managers Information 

The Trusted Managers option allows you to assign special permissions to an SNMP 
manager. Special permissions include, for example: the ability to launch applications. 

1. Choose the NEWT icon. 

2. Choose the Trusted Managers ... command from the SNMP menu. 

3. Enter the node IP address or name from the list of SNMP managers provided in the 
field. 

4. Choose the OK button. 

Trap Administration Information 

The trap administration option allows you to determine which destinations receive 
notification from an SNMP agent. To enter trap administration information, do the 
following: 

1. Choose the NEWT icon. 

2. Choose the Trap Administration ... command from the SNMP menu. 

3. Enter the default destination to where SNMP agent notification will be sent. 

4. If desired, select additional preferences and choose the OK button. 
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Community Information 

The Community ... option allows you to enter the community string you want to apply to 
the Get and Set receipt operations. When you do not enter community field information, 
the community is not checked and any message is accepted. To enter Community 
information, do the following: 

1. Choose the NEWT icon. 

2. Choose the Community ... command from the SNMP menu. 

3. Enter the string you want to apply in the Get and Set fields. 

Many systems use a community of "public" for Get and "private" for Set. Note that 
the text you enter in each field is case sensitive and your selections are saved 
encrypted in the configuration file. 

4. Choose the OK button. 

This personalized information is now included in the administration portion of the MIB­
II in your agent. 
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C.11a pte.r·· •• ·.46·. 
The Diagnostic Center is comprised of the Trace Agent, which is a Windows-based 
SNMP application that performs packet capture of every TCP/IP packet that goes in and 
out of your PC. When a trace is created, it becomes available for detailed packet 
analysis. The analysis can be performed by sending the files to NetManage Technical 
Support for diagnosis or by using the NEWTTrace application. 

You can activate the Diagnostic Center one of the following ways: locally or remotely. 

• Locally - by the user. Choose the Trace Agent icon to display the pop-up menu, and 
select the Start option. Later, when you select Stop, it prompts you for a filename to 
which you want to write the trace. This file may then be analyzed by the 
NEWTTrace application. 

• Remotely - by a manager/support engineer who may need this data for 
troubleshooting/analysis. When activated remotely it complies fully with Remote 
Monitoring (RMON). 

Restore 
Move 

Ma;:5;imize 

!;.Iose AIt+F4 

S}!£itch To ... Ctrl+Esc 

Jjelp 

About Trace Agent ... 

RMON is an industry standard definition for network information collected remotely by 
any SNMP (Simple Network Management Protocol) based system. 

RMON is widely accepted as the standard for performing remote functions such as 
trouble shooting, performance monitoring, and accounting. Using RMON insures 
compatibility with the widest range of management devices. 

NEWTTrace is part of NEWTWatch, which is a separate administrative Desktop 
Management Package offered by NetManage. It performs full protocol decoding. It 
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takes its input from any trace collected by the Trace Agent present in the Chameleon, or 
any other RMON-compliant device. 

It is especially useful for developers of network applications, and administrators 
performing protocol and application troubleshooting. 
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Internet Relay Chat (IRC) is a multi-user, multi-channel chatting network. It lets people 
connected to the Internet talk to one another in real-time. Conversations take place in 
areas called channels. A channel is a separate and distinctive electronic meeting area 
where people can talk simultaneously. There can be any number of channels in IRC, and 
any number of people within a channel. Some channels exist all the time, while others 
come and go as the need arises. 

Each channel usually has at least one operator, who is responsible for managing the 
channel. Channel operators control the channel and have special privileges to maintain 
it. The initial creator (and the first person) of a channel has channel operator privileges 
and can give or take away these privileges to others on the channel. 

Users are known by a nickname. This nickname must be unique on the network at the 
time and is limited to nine characters. Nicknames are really not owned because you may 
find your normal nickname in use the next time you connect to IRC, and will be asked to 
use another nickname for that session. 

While on a channel, all normal text that you enter goes to the channel for all others to 
see. The one exception to this is if the text starts with a slash. A slash means the text 
that follows should be interpreted as a server command. 

The IRC server that you connect to defines what network you are on. There is one main 
network often referred to as EFFNET. EFFNET usually hosts about 2500 channels with 
up to 5000 people at peak times. Other networks have improved the servers in varying 
ways and have fewer members (examples include UNDERNET and DALNET). 
Volunteers, usually at colleges and universities, operate and maintain these networks of 
servers. These networks are not secure; do not assume any form of privacy. 

Connecting to IRC 
To start the IRC application, choose the IRC icon to display the main IRC window. 
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There are two types of tabs: a Server tab and a Channel tab. There is only one Server 
tab, which has two main text areas. The top text area, the Server Information box, is 
where server output is displayed. This area can also contain error messages if local 
operations fail. The bottom text area, the Channel box, lists the current channels on the 
connected server. It displays the channel name, the number of users on the channel, and 
the topic. 

There are as many channel tabs as there are channels that you have joined (the 
maximum is ten). When you join a channel, a new channel tab is created and brought to 
the top. It contains a small text box on top with the topic and any status information, 
and a large area for the channel conversation text on the bottom. 

To connect, do the following: 

1. Select either the Connect! menu option on the menu bar or the Connect button on 
the Server tab to display the Information not found dialog box. This dialog box 
explains what information you must enter to connect to an IRC server as a first-time 
user. 

2. Choose the OK button to display the User Preferences dialog box. 
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3. Under the User tab, enter your nickname in the Default nickname: field. This name 
can be nine characters or less. 

4. Enter another nickname in the Alternate nickname checkbox if you want to 
automatically try another nickname when your default nickname is in use. 

5. Enter your username if it is blank. 

6. Enter you hostname.The local hostname is the actual machine name. The username 
and the local hostname might already be filled in if the IRC client can get this 
information from the local machine. 

7. Enter a single line of text identifying yourself in the Description: field (this is 
optional). 

8. In the "Away" text: field, enter a single line of text that will be sent to people when 
you are away from IRC, but still connected and someone sends you a private 
message. This is also optional. 

9. When you have entered information in all these fields, choose the Server tab to 
display the Server Preferences dialog box. 

10. Select a server from the list in the drop-down menu or enter one in this field. 

11. Leave 6667 as the port number unless you know a server uses a different port 
number. 
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12. The Current server list from file field shows the default server network selection. 
Choose the Browse button to display the Select server list dialog box. 

13. Select one of the server networks listed in the File Name: field, then choose the OK 
button. The Current server list from file field is then updated with the network 
server that you have selected. 

14. Select the Connect button on the Server tab or the Connect! menu option. 

After connecting, the Server Information box shows the following information: 

• The number of IRC users 

• The number of channels being used 

• Other information that the server may send 

After connecting, the Channel List box shows the following information: 

• The Channel column shows the names of channels in use. 

• The Users column shows the number of users on that channel. 

• The Topic column describes the subject being discussed and may be blank. 

Note: Your currently used nickname now appears in the Nickname: field. 

From here, you can browse the channel list, join a channel, or create a new channel. 
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Setting Preferences 
To set Preferences, do the following: 

1. Select the Settings menu, then choose the Preferences ... command to display the 
Preferences Options dialog box. 

2. Select the Misc tab to display the Misc Preferences dialog box. 

3. If you do not want to be on the list of current users, choose the Invisible to other 
users checkbox. 

4. To automatically connect to a server after startup, choose the Automatically connect 
to server on startup checkbox. Select this setting to enable automatic connection to 
your IRC server the next time you start IRC. 

5. To automatically enlarge your window to the largest possible size after startup, 
choose the Automatically maximize window on startup checkbox. 

6. To automatically retrieve the channel list after startup, choose the Automatically 
retrieve channel list on connect checkbox. This is the default. 

7. If you want to join a specific channel or channels automatically after startup, enter 
the channel name or names, separated by commas in the Auto-load channel(s): 
field. 

8. Choose the OK button when you are done. The changes will take effect in your next 
IRC session. 

Creating a New Channel 
To create a new channel, do the following: 

1. From the IRC window, select the Create .. button to display the Create Channel 
dialog box. 
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2. In the Channel Name: field, enter the new channel name, beginning with a pound 
sign. Channel names are not case sensitive and cannot contain spaces or cOmmas. 
You can create up to 10 channel tabs. If the channel you enter already exists, IRC 
treats it as if you were joining the channel. 

3. In the Topic: field, enter the new topic name. 

4. If you do not want your channel name to be listed, choose the Private (listed as . 
"PRV" without topic) checkbox. 

5. If you do not want any channel information to be listed, choose the Secret (not listed 
at all): checkbox. Use this selection for privacy. 

6. If you want to give permission to talk to other users, choose the Moderated: 
checkbox. 

7. If you want to reserve the right to change a channel topic, choose the Topic can only 
be changed by channel operator: checkbox. 

8. If you want to let other users join your new channel only by invitation, choose the 
Invite Only: checkbox. 

9. If you do not want messages directed to the channel (from outside the channel) to 
appear, choose the No messages to channel from outside: checkbox. Use this 
selection as another level of privacy. 

10. To limit the number of users on a channel, choose the Limit number of users to: 
checkbox and enter the number you want. 

11. To liwit the number of users by requiring a pass\'1/0rd to join a channel, choose the 
Use a channel key (password): checkbox and enter the password. 

12. Choose the OK button when you are done. 

For example, if you have created a new channel named #chameleon, a new channel tab 
is created and added to the tab list, following the Server tab. 
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Using IRe 
To join an existing channel, from the Server tab, select the channel and choose the Join 
button. The channel tab of the channel you joined appears after the Server tab. 

To leave the channel you are using, from the Channel tab, choose the Leave button. The 
channel tab then disappears. 

To view a list of channel members, from the Server tab, choose the List Members ... 
button to display the List of members dialog box. 

After reviewing the list, choose the OK button. 

To change nicknames, do the following: 

1. From the Toolbar, choose the Nickname: button to display the Change nickname: 
dialog box. 
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2. Enter the new nickname in the New nickname: field, then choose the OK button. 
This change is temporary, and is only in effect during the current session. All 
member lists and channels are updated when you change your nickname. 

The WhoIs .. ?, Ignore, and Set Topic buttons are enabled even if you are not the channel 
operator. 

The Mode, Invite, Kick, and Ban buttons are only enabled if you are a channel operator. 

Caution: Preceding a message with a slash sends the message directly to the server as a 
command. Do this only if you are an experienced IRe user. 

Entering a Message and Getting Member Information 
To enter a message into the channel, do the following: 

1. Enter the'text in the Prepare your message here: field. 

2. When you are done, choose the Send button or press the Enter key. The message 
appears in the Output column so that all users can see it. 

To get information about a member on the channel, select a username in the Member 
column and choose the WhoIs ... ? button to display the User Information dialog box. 

This dialog box shows the nickname, username, description, server connected to, idle 
time (how long the member has not typed on the keyboard) and lists all the channels the 
user belongs to. 

Note: To get information on anyone using the IRe server, select the WhoIs? command 
in the Member menu instead of the WhoIs? button in the IRe window. 

To get information about a previous user who has disconnected from IRe, do the 
following: 

1. From the Member menu, select the Who Was? .. command to display the Who 
was ... ? dialog box. 
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2. Enter the nickname of the user you want information about, then choose the OK 
button. Check the Server Information box for a response to this request. 

To prevent receiving messages from a specific user, do the following: 

1. From the Channel tab, select the member from the Members: column, then choose 
the Ignore button to display the Ignore nickname: dialog box. 

2. Enter the nickname of the user that you do not want to receive messages from in the 
Nickname to ignore: field, then choose the Add button. 

3. To remove users from this list, choose the Remove button. When you have finished 
adding or deleting nicknames, choose the Done button. 

To set a new topic, do the following: 

1. From the Channel tab, choose the Set Topic button to display the Set new topic 
dialog box. 

2. Enter the new channel topic, then choose the OK button. The output column shows 
the updated topic. 

Using Filters 
To show a range of the number of members on a channel, use filters. An x in the Filter 
checkbox indicates that filters are enabled for this session. 
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To add filters, do the following: 

1. From the Server tab, select the Filter button to display the Filter/Search Channels 
dialog box. 

2. Enter a number in the Min: and Max: checkboxes to define a range of users. 

3. To search for text in a channel name, enter the text in the Text to match: field, then 
choose the OK button or press the Enter key. 

To remove all filters, select the Remove filters button in the Filters/Search Channels 
dialog box, then choose the OK button. 

Changing and Updating Topics, Users, and Channels 
To change channel modes, do the following (only if you are a channel operator): 

1. Choose the Mode button to display the Change channel modes dialog box. 

2. See the Creating a New Channel section for information on how to complete the 
fields in this dialog box. 

In the Channel column, select the right mouse button to display the following popup 
menu: 

Get Channel List (or refresh) 

I tllter ... 

• Choose the Get Channel List (or refresh) command within the channel list to 
refresh and update the channels, users, and topics for all channels that exist on 
the server. 

• Choose the Filter .. command to redisplay the Filter/Search Channels dialog box 
and change your filter ranges. 
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From a channel tab, in the Output column, select the right mouse button to display the 
following popup menu: 

• Choose the Pause scrolling command to stop items added to the channel from 
scrolling up and out of view. 

• Choose the Clear command to continue scrolling. 

From a channel tab, in the Members: column, select the right mouse button to display 
the following popup menu: 

Who Is? 

Give Ops 
Take away Ops 
Kick from channel 
Ban from channel 
Private message 

• Choose the Whols? command to display current user information in the selected 
channel. 

• Choose the Give Ops command to give operator rights to any user on the channel. 

• Choose the Take away Ops command to take away operator rights from any user on 
the channel. 

• Choose the Kick from channel command to remove a user from the channel. 

• Choose the Ban from channel command to prevent a user from rejoining the 
channel. 

• Choose the Private message command to send a private message to a specific 
member on the channel. 

Removing or Banni'ng Users from a Channel 
To remove a user from a channel, choose the Kick button. Any channel operator on that 
channel has these privileges. A message is displayed in the Output column, informing 
other members that a specific user has been kicked off the the channel. 

To prevent a user from rejoining a channel (Any channel operator on that channel also 
has these privileges.), do the following: 

1. From the Channel tab, choose the Ban button to display the Ban dialog box. 
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2. Enter the name of the user in the Nickname to ban: field, then select the Add 
button. The Ban will be: field is updated with the name of the user you want to ban. 

3. Select the Ban this user option to ban a single user. 

4. Select the Ban this host option to ban all users from that user's host. 

S. To remove a ban, select the nickname of that user from the Cancel ban: field, then 
choose the Remove button. 

6. When you are fin~shed adding or removing nicknames, choose the Done button. 

Disconnecting from IRe 
To disconnect from an IRC server, do the following: 

1. Select either the Disconnect! menu option or the Disconnect button on the Server 
tab. 

2. The Server Information box is updated and all channel tabs are removed, indicating 
that you are no longer connected. 

Troubleshooting 
o If you cannot connect to a server, do the following: 

• Make sure that a valid server name appears in Preferences on the Server tab. 
The port number is almost always 6667 unless otherwise instructed. 

• Select the Help menu and choose the Diagnose Connection .. command to see if 
you can ping the server. 

• Wait-sometimes the servers takes several minutes to respond. 

• You or your site has been banned from that server. 

o If changes do not occur immediately after you make them, do the following: 

• Be aware that very busy servers may respond slowly. 

• Wait-you may not see a screen display change until the server confirms the 
action you performed. 
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o If you made a change and nothing happened, do the following: 

• A server may silently ignore an incorrect or redundant request. For example, if 
you try to set a mode on a channel that already has that mode, nothing happens 
and you receive no error messages. 

• Check the Server Information box on the Server tab: it may have an error 
message displayed. Error dialogs do not appear because they may be out of 
order and confusing. 

o If you repeatedly get disconnected when you connect to a server, do the following: 

• Check the server information box for any messages. 

• Try changing your nickname or try another IRC server or another IRC network. 

o If you cannot join or create a channel, check the Server Information box on the 
Server tab. Perhaps the channel already exists and is Invite only, needs a keyword, 
has a user limit, or has banned you. 

o It is possible that the servers listed in the Current server list from file: field are no 
longer available. If you know the name of a valid IRC server, enter it in this field. 
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Note: This appendix is intended ONLY for users that are: 

• installing ChameleonNFS to run in a Windows for Workgroups environment. 

• installing ChameleonNFS on Windows for Workgroups using a third-party TCPIIP 
stack. 

• using OEM Setup for Windows for Workgroups 

Installing Windows for Workgroups 
Generally, the Install application makes all the necessary changes to your configuration. 
However, if you are upgrading from Chameleon 3.11 or earlier, you may refer to this 
section for additional information. (You may also refer to this section to see a list of 
changes that have been made automatically to your configuration.) 

The section includes separate headings, describing how ChameleonNFS is configured to 
coexist with each of the following: 

• Windows for Workgroups version 3.11 over NDIS 

• Windows for Workgroups version 3.11 over NDIS with no workgroups networking 
installed. 

• Windows for Workgroups version 3.11 and Novell version 3.X shell/ODI or later. 

• Windows for Workgroups version 3.11 and Novell version 3.X shell/ODI or later, 
with no workgroups networking installed. 

Prerequisites 

Before installing ChameleonNFS make sure that Windows for Workgroups is configured 
properly and all functions are operational. It is recommended that you upgrade to 
Windows for Workgroups version 3.11 from 3.10 or Windows 3.1 to have a successful 
install. 

Over NDIS 
This section describes configuring ChameleonNFS version 4.5 or later to coexist with 
Windows for Workgroups version 3.11 over NDIS. 

Follow these steps: 
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1. Install Windows for Workgroups, version 3.11. 

2. Install ChameleonNFS according to the installation instructions below: 

ChameleonNFS Installation Instructions 

Your ChameleonNFS product includes several diskettes. 

New Installation 

To install the product for the first time, start Windows in enhanced mode: 

1. Insert the NFS diskette in the drive of your choice (a:\ in this example). Select the 
Run ... option under the File menu in Program Manager and type: a: \setup. 
Then choose the OK button. 

2. Continue to insert the remaining diskettes when prompted. 

At this point, Setup will start Custom. The Custom application guides you through 
a customized configuration portion of your installation with a short series of dialog 
boxes, prompting you to make selections. 

Note that you will not be prompted for setting domain servers and entries for Host 
Table. You must manually define these names for name resolving. 

3. Select the Save option from the File menu and exit the Custom application. 

4. At the prompt, remove all diskettes and choose the OK button to reboot. 

Upgrade Installation 

To upgrade from a previous NetManage installation, start Windows in enhanced mode: 

Note: Make sure that you do not have PROTMAN.DOS and NETMANAG.DOS 
drivers loaded in CONFIG.SYS. In addition, NETBIND and ODINSUP should 
be removed from the AUTOEXEC.BAT file. 

Quit all Chameleon applications and any other TCP/IP applications. 

1. Insert the NFS diskette in the drive of your choice (a: \ in this example). Select the 
Run ... option under the File menu in Program Manager and type: a: \setup. 
Then choose the OK button. 

2. Continue to insert the remaining diskettes when prompted. 

3. At the prompt, remove all diskettes and choose the OK button to reboot. 

4. In case NFS was not installed or was installed improperly, do the following: 

• Choose the Network icon from the Control Panel icon. 
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• Select the NetManage ChameleonNFS (all versions) from the list and choose 
the Install ... button. This network is added to the list of Installed Networks. 

• Select Windows for Workgroups from the list and choose the Install. .. button 
and make it your default network. 

• Choose the OK button. The NEWT icon will appear on your screen. 

The following files will be modified: 

• AUTOEXEC.BAT 

• WIN.lNI 

• SYSTEM.lNI 

• PROTOCOL.lNI 

Verifying the Changed Files 

The automated Install program generally makes all the necessary modifications. If you 
experience any problems with these modifications, check these files as follows: 

File Name: AUTOEXEC.BAT 

Modifications: Adds NETMANAG to Path. 

Example: 

C:\WINDOWS\SMARTDRV.EXE 
C:\WINDOWS\net start 
PATH C:\NETMANAGiC:\WINDOWSidos 
SET TEMP=C:\WINDOWS\TEMP 

Note: If a NETBIND statement exists from a previous installation of NetManage, you 
must remove it. The NETBIND functionality is performed by the NET START 
command provided by Windows for Workgroups. 

File Name: CONFIG.SYS 

Modifications: None 

Note: Do not load the IFSHLP.SYS file into high memory. 

There should not be a NETMANAGE.DOS device driver in CONFIG.SYS. 
Many of the drivers that were loaded from CONFIG.SYS previously, are now 
loading from the SYSTEM.lNI file. See the example of the SYSTEM.lNI file. 

File Name: WIN.INI 

Modifications: Adds [TCPIP] section 

Example: 

[TCPIP] 
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ID=XXX. .. (your encrypted serial number) 
FILE=C:\NETMANAG\TCPIP.CFG 

Note: You should create a pasted backup of the [TCPIP] section for future possible 
troubleshooting. 

File Name: SYSTEM.INI 

Modifications: 

• uses MULT46.DRV as secondary network driver only for a new install, or as a 
primary network driver only for an upgrade 

• updates boot description 

• adds nmredir and NMTCPIP.386 in [386Enh] section 

• changes [network drivers] section 

• changes LoadRMdrivers value from No to Yes 

Example: 

[boot] 
shell=progman.exe 
secondnet.drv=C:\NETMANAG\MULT46.DRV 

The installation of the MULT46.DRV driver as secondary network driver allows the 
user to run more than one network at the same time with Windows For Workgroups. 
Once the MULT46.DRV driver is loaded, it automatically loads additional drivers. 

The following lines will be added to the [boot description] section: 

[boot.description] 
secondnet.drv=NetManage ChameleonNFS 

The following lines will be added to the [386Enh] section: 

[386Enh] 
iBEGIN NetManage Modification. 
device=c:\netmanag\nmtcpip.386 
device=c:\netmanag\nmredir.386 
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;END NetManage Modification. 

In the [network drivers] section, the netmanag.dos driver is added to the transport line: 

[network drivers] 
netcard=elnk3.dos 
transport=ndishlp.sys,c:\netmanag\netmanag.dos,*netbeui 

Install changes the value for LoadRMDrivers line from No to Yes. 

devdir=C:\WINDOWS 
LoadRMDrivers=Yes 

Note: Because the WFWNET.DRV driver is already loaded as the primary network (for 
a new install) in the SYSTEM.INI file, you must not attempt to reload it using 
the Control Panel Network. 

File Name: PROTOCOL.INI 

Modifications: Adds [netmanag] section 

Example: 

[network. setup] 
version=Ox3110 
netcard=ms$elnk3,1,MS$ELNK3,3 
transport=ms$nwlinknb,NWLINK 
transport=ms$ndishlp,MS$NDISHLP 
transport=ms$netbeui,NETBEUI 
lanaO=ms$elnk3,1,ms$nwlinknb 
lanal=ms$elnk3,1,ms$ndishlp 
lana2=ms$elnk3,1,ms$netbeui 
[protman] 
DriverName=PROTMAN$ 
PRIORITY=MS$NDISHLP 
[NETMANAGE] 
DRIVERNAME=netmng$ 
BINDINGS=MS$ELNK3 
[MS$ELNK3] 
DriverName=ELNK3$ 
[ELNK3 ] 
Adapters=MS$ELNK3 
[NWLINK] 
BINDINGS=MS$ELNK3 
[MS$NDISHLP] 
DriverName=ndishlp$ 
BINDINGS=MS$ELNK3 
[NETBEUI] 
DriverName=netbeui$ 

<=== Inserted during Netmanage install 
<=== network card section 
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SESSIONS=10 
NCBS=12 
BINDINGS=MS$ELNK3 
LANABASE=l 

Setting MUL TILAN.DRV as a Primary or Secondary 
Network 
When MULTILAN.DRV is used as the primary network, other networks can be 
installed through this application. The SECONDNET.DRV file in the SYSTEM.INI file 
becomes unnecessary and you can leave it blank in this case. Although this allows file 
sharing among installed multiple networks, some of the Windows for Workgroups 
networking features become disabled. 

Applications such as Windows for Workgroups Mail, WinPopup and Windows for 
Workgroups printer sharing will not work if Windows for Workgroups is not configured 
as the primary network. 

In ChameleonNFS version 4.5 and later, this problem is resolved if you configure 
MULTILAN.DRV as the second network. In this case Windows for Workgroups 
network redirector WFWNET.DRV can become the primary network and 
MULTILAN.DRV can be the secondary network. Other networks such as Novell can 
still be installed from the multilan application. 

To configure MULTILAN.DRV as the secondary network, do the following: 

1. Remove MULTXXX.DRV from the primary= statement in the boot section of 
SYSTEM.INI. 

2. Install Windows for Workgroups networking from the Network Setup application in 
the Network program group of the Windows for Workgroups program manager. 

3. Once Windows for Workgroups is properly installed, add the path to your 
MULTXXX.DRV to SECONDNET.DRV= parameter in the boot section of the 
SYSTEM.INI. 

4. Modify your MULTILAN.CFG file in the directory where you have installed 
ChameleonNFS files. 

5. If you used the Windows for Workgroups network via MULTILAN.DRV as the 
secondarj network, then remove the "Install Windows for Workgroups network" 
statment from the Installed section in the MULTILAN.CFG file. 

If this line exists in the MULTILAN.CFG file and you changed Windows for 
Workgroups to run as the primary network, and MULTILAN.DRV as the secondary 
network, your system crashes upon loading Windows. 
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The setup program, by default, configures MULTILAN.DRV as the secondary network 
for new installation of ChameleonNFS on a Windows for Workgroups configured 
system. 

Over NDIS with No Workgroups Networking Installed 
This section describes configuring ChameleonNFS version 4.5 or later to coexist with 
Windows for Workgroups version 3.11 over NDIS with no Workgroups Networking 
installed. 

Follow these steps: 

1. Install Windows for Workgroups, version 3.11. 

2. Install ChameleonNFS according to the installation instructions below: 

ChameleonNFS Installation Instructions 

Your ChameleonNFS product includes several diskettes. 

New Installation 

To install the product for the first time, start Windows in enhanced mode: 

1. Insert the NFS diskette in the drive of your choice (a:\ in this example). Select the 
Run ... option under the File menu in Program Manager and type: a: \setup. 
Then choose the OK button. 

2. Continue to insert the remaining diskettes when prompted. 

At this point, Setup will start Custom. The Custom application guides you through 
a customized configuration portion of your installation with a short series of dialog 
boxes, prompting you to make selections. 

Note that you will not be prompted for setting domain servers and entries for Host 
Table. You must manually define these names for name resolving. 

3. Select the Save option from the File menu and exit the Custom application. 

4. At the prompt, remove all diskettes and choose the OK button to reboot. 

Upgrade Installation 

To upgrade from a previous NetManage installation, start Windows in enhanced mode: 

1. Quit all Chameleon applications and any other TCP/IP applications. 

2. To close the NEWT application: 

• Choose the Network icon from the Control Panel icon. 
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• Select NetManage ChameleonNFS (all versions) from the list of networks and 
choose the Remove ... button. The NEWT icon will disappear from your 
screen. 

3. Insert the NFS diskette in the drive of your choice (a:\ in this example). Select the 
Run ... option under the File menu in Program Manager and type: a: \ setup. 
Then choose the OK button. 

4. Continue to insert remaining diskettes when prompted. 

5. At the prompt, remove all diskettes and choose the OK button to reboot. 

6. In case NFS was not installed or was installed improperly, do the following: 

• Choose the Network icon from the Control Panel icon. 

• Select the NetManage ChameleonNFS (all versions) from the list and choose 
the Install ... button. This network is added to the list of Installed Networks. 
You need to make this network your default network. 

• Choose the OK button. The NEWT icon will appear on your screen. 

Verifying the Changed Files 

The automated Install program generally makes all the necessary modifications. If you 
experience any problems with these modifications, check the following files: 

• AUTOEXEC.BAT 

• CONFIG.SYS 

• WIN.INI 

• SYSTEM.INI 

• PROTOCOL.INI 

File Name: AUTOEXEC.BAT 

Modifications: Adds a line for NETBIND and adds NetManag to Path line. 

Example: 

C:\NETMANAG\NETBIND 
C:\WINDOWS\SMARTDRV.EXE 
PATH c: \ NET}1ANAG ; C ; \ ~'nNDOViTS ; C : \ Do s 

SET TEMP=C:\WINDOWS\TEMP 

File Name: CONFIG.SYS 

Modifications: Adds NDIS driver 

Example: 

FILES=30 
BUFFERS=30 
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LASTDRIVE=Z 
DEVICE=C:\WINDOWS\HIMEM.SYS 
DEVICE=C:\WINDOWS\SMARTDRV.EXE /DOUBLE BUFFER 
DEVICE=C:\WINDOWS\IFSHLP.SYS 
STACKS=9,256 
DEVICE=C:\NETMANAG\PROTMAN.DOS /I:C:\NETMANAG 
DEVICE=C:\NETMANAG\ELKNII.DOS 
DEVICE=C:\NETMANAG\NETMANAG.DOS 

File Name: WIN.INI 

Modifications: Adds [TCPIP] section 

Example: 

[TCPIP] 
ID=XXX. .. (your encrypted serial number) 
FILE=C:\NETMANAG\TCPIP.CFG 

Note: You should make a pasted backup of the [TCPIP] section for future possible 
troubleshooting. 

File Name: SYSTEM.INI 

Modifications: 

• uses MULT46.DRV as primary network driver 

• updates boot description 

• adds nmredir.386 and nmtcpip.386 in [386Enh] section 

Example: 

[boot] 
shell=progman.exe 
network.drv=C:\NETMANAG\MULT46.DRV 

The installation of the MULT46.DRV driver as primary network driver allows the user 
to run more than one network at the same time with Windows For Workgroups. Once 
the MULT46.DRV driver is loaded, it automatically loads additional drivers. Please 
refer to the chapter titled NFS -Network Drives for more information about mUltiple 
networks and MULT46.DRV functionality. 

The following lines will be added to the [boot description] section: 

[boot.description] 
network.drv=NetManage ChameleonNFS 
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The following lines will be added to the [386Enh] section: 

[386Enh] 
iBEGIN NetManage Modification. 
device=C:\netmanag\nmtcpip.386 
device=c:\netmanag\nmredir.386 
iEND NetManage Modification 

File Name: PROTOCOL.INI 

Modifications: Adds [NETMANAG] section 

[EtherLink3] 
DRIVERNAME=ELNK3 
[protman] 
[NETMANAGE] 
DRIVERNAME=netmng$ 
BINDINGS=EtherLink3 

With Novell and Workgroups Networking 
This section describes configuring ChameleonNFS version 4.5 or later to coexist with 
Windows for Workgroups version 3.11 and Novell3.X or later running in the ODI 
environment. 

Prerequisites 

Before installing ChameleonNFS make sure that Windows for Workgroups is configured 
to run with Novell over ODI and all of the Novell and Windows for Workgroups 
functions are working properly. In particular, make sure that Novell's latest version of 
LSL.COM is loaded. 

Note: We highly recommend installing the Novell network over ODI before installing 
the Windows for Workgroups. 

Once the two networks, Microsoft Windows Network 3.11 and Novell NetWare (shell) 
are functioning properly over ODI, you can install ChameleonNFS. The new version of 
ChameleonNFS (4.5) will automatically detect the ODI and Windows For Workgroups 
environments and will make the necessary changes. 

Follow these steps: 

1. Install Windows for Workgroups, version 3.11. 

2. Install ChameleonNFS according to the installation instructions below: 
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ChameleonNFS Installation Instructions 

Your ChameleonNFS product includes several diskettes. 

New Installation 

To install the product for the first time, start Windows in enhanced mode: 

1. Insert the NFS diskette in the drive of your choice (a:\ in this example). Select the 
Run ... option under the File menu in Program Manager and type: a: \setup. 
Then choose the OK button. 

2. Continue to insert the remaining diskettes when prompted. 

At this point, Setup will start Custom. The Custom application guides you through 
a customized configuration portion of your installation with a short series of dialog 
boxes, prompting you to make selections. 

Note that you will not be prompted for setting domain servers and entries for Host 
Table. You must manually define these names for name resolving. 

3. Select the Save option from the File menu and exit the Custom application. 

4. At the prompt, remove all diskettes and choose the OK button to reboot. 

Upgrade Installation 

Please refer the section titled, Setting MULTILAN.DRV as a Primary or Secondary 
Network, for detailed information about setting the MULTILAN.DRV as a primary or 
secondary network. 

To upgrade from a previous NetManage installation, start Windows in enhanced mode: 

Note: Make sure that you do not have PROTMAN.DOS and NETMANAG.DOS 
drivers loaded in CONFIG.SYS. In addition, NETBIND and ODINSUP should 
be removed from the AUTOEXEC.BAT file. 

Note: Be sure to configure Windows for Workgroups for ODI before continuing. 

1. Quit all Chameleon applications and any other TCP/IP applications. 

2. To close the NEWT application: 

• Choose the Network icon from the Control Panel icon. 

• Select NetManage ChameleonNFS (all versions) from the list of networks and 
choose the Remove ... button. The NEWT icon will disappear from your 
screen. 

3. Insert the NFS diskette in the drive of your choice (a:\ in this example). Select the 
Run ... option under the File menu in Program Manager and type: a: \setup. 
Then choose the OK button. 
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4. Continue to insert the remaining diskettes when prompted. 

5. At the prompt, remove all diskettes and choose the OK button to reboot. 

6. In case NFS was not installed or was installed improperly, do the following: 

• Choose the Network icon from the Control Panel icon. 

• Select the NetManage ChameleonNFS (all versions) from the list and choose 
the Install ... button. This network is added to the list of Installed Networks. 

• Select Windows for Workgroups from the list and choose the Install ... button. 
You need to make this network your default network. 

• Choose the OK button. The NEWT icon will appear on your screen. 

The following files will be modified: 

• NET.CFO 

• AUTOEXEC.BAT 

• WIN.INI 

• SYSTEM.INI 

• PROTOCOL.INI 

Verifying the Changed Files 

The automated Install program makes all the necessary modifications. If you experience 
any problems with these modifications, check these files as follows: 

The following NET.CFO file was created by Windows for Workgroups when configured 
to support Novell NetWare. The ChameleonNFS added more settings to this file. The 
order of the Frame and Protocol statements is important. 

Please refer to the Ethernet and IBM Token Ring examples below. 

NET.CFG 
#Ethernet Adapter 
Link Driver 3C509 

Frame Ethernet 802.3 
Frame Ethernet_802.2 
Frame Ethernet_SNAP 
Frame Ethernet_II 
Protocol RARP 8035 ethernet ii 
Protocol ARP 806 ethernet_ii 
Protocol IP 800 ethernet_ii 

#IBM Token Ring Adapter 
Link Driver TOKEN 
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Frame TOKEN-RING 
Frame TOKEN-RING_SNAP 
Protocol IPX EO TOKEN-RING 
Protocol IP800 TOKEN-RING_SNAP 
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Protocol ARP 
Protocol RARP 

806 
8035 

TOKEN-RING_SNAP 
TOKEN-RING_SNAP 

The installation of ChameleonNFS will add the NMODI driver to the 
AUTOEXEC.BAT file. This driver allows ChameleonNFS to run on top of OD!. 

File Name: AUTOEXEC.BAT 

Modifications: Install makes the following changes to this file: 

• Adds nmodi 

• Adds netmanag to Path 

Note: The Windows for Workgroups configuration should include the ODIHLP.EXE 
driver in this file. While you are verifying the file, check also for the ODI driver. 

Example: 

C:\WINDOWS\net start 
@ECHO OFF 
PATH C:\NETMANAGiC:\WINDOWSiC:\DOSiC:\ODI 
PROMPT=$p$g 
c:\odi\lsl 
c:\odi\3c509 
Interface Card 
c:\odi\ipxodi 
c:\netmanag\nmodi 
C:\WINDOWS\odihlp.exe 
c:\odi\netx 

File Name: CONFIG.SYS 

Modifications: None 

Example: 
FILES=30 
BUFFERS=30 
LASTDRIVE=Z 

<=== The ODI driver for your Network 

<=== Added by the Install program 

DEVICE=C:\WINDOWS\HIMEM.SYS 
DEVICE=C:\WINDOWS\SMARTDRV.EXE /DOUBLE_BUFFER 
DEVICE=C:\WINDOWS\IFSHLP.SYS 
STACKS=9,256 

File Name: WIN.INI 

Modifications: Adds [TCPIP] section 

Example: 

[TCPIP] 
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ID=XXX. .. (your encrypted serial number) 
FILE=C:\NETMANAG\TCPIP.CFG 

Note: You should make a pasted backup of the [TCPIP] section for future possible 
troubleshooting. 

File Name: SYSTEM.INI 

Modifications: Makes the following changes: 

• Uses MULT46.DRV as secondary network driver only for a new install, and as a 
primary network driver only for an upgrade 

• Updates boot description 

• Adds nmredir.386 and nmtcpip.386 in [386Enh] section 

Example: 

[boot] 
secondnet.drv=C:\NetManag\mult46.drv 
[boot description] 
secondnet.drv=NetManage ChameleonNFS 

The following lines will be added to the [386Enh] section: 

[386Enh] 

;BEGIN NetManage Modification. 
device=C:\netmanag\nmtcpip.386 
device=c:\netmanag\nmredir.386 
;END NetManage Modification. 

Windows For Workgroups provides support for only two networks. In order to access 
Novell, Windows For Workgroups and ChameleonNFS at the same time, we install 
MULT46.DRV driver as the secondary network driver for a new install. MULT46.DRV 
remains a primary network for an upgrade 

MULT46.DRV is the driver developed by NetManage for the support of multiple 
networks at the same time. By installing the MULT46.DRV driver as secondary network 
driver we allow the user to run more then two networks at the same time with Windows 
For Workgroups. Once the MULT46.DRV driver is loaded it will load additional drivers 
automatically. 

Following is an example of a PROTOCOL.INI file. 

Example: PROTOCOL.INI 

[network. setup] 
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version=Ox3110 
netcard=ms$odimac,l,MS$ODIMAC,4 
transport=ms$nwlinknb,NWLINK 
transport=ms$netbeui,NETBEUI 
lanaO=ms$odimac,l,ms$netbeui 
lanal=ms$odimac,l,ms$nwlinknb 
[net.cfg] 
PATH=C:\WINDOWS\net.cfg 

[MS$ODIMAC] 
[Link Driver 3c509] 
data=Frame Ethernet_802.3 
data=Frame Ethernet_802.2 
data=Frame Ethernet_SNAP 
data=Frame Ethernet_II 
data=Link Driver 3c509 
[NWLINK] 
BINDINGS=3c509 
[NETBEUI] 
BINDINGS=3c509 
LANABASE=O 
SESSIONS=lO 
NCBS=12 

With Novell with No Workgroups Networking Installed 
This section describes configuring ChameleonNFS version 4.5 to coexist with Windows 
for Workgroups version 3.11 and Novell3.X or later running in the ODI environment, 
with no Workgroups networking installed. 

Prerequisites 

Before installing ChameleonNFS make sure that Windows for Workgroups is configured 
to run with Novell over OD!. 

Note: We highly recommend installing the Novell network over ODI before installing 
the Windows for Workgroups. 

Once Windows for Workgroups and Novell NetWare (shell) are functioning properly 
over ODI, you can install ChameleonNFS. The new version of ChameleonNFS (4.5) will 
automatically detect the ODI and Windows For Workgroups environments and will 
make the necessary changes. 

Follow these steps: 

1. Install Windows for Workgroups, version 3.11. 

2. Install ChameleonNFS according to the installation instructions below: 
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ChameleonNFS Installation Instructions 

Your ChameleonNFS product includes several diskettes. 

New Installation 

To install the product for the first time, start Windows in enhanced mode: 

1. Insert the NFS diskette in the drive of your choice (a:\ in this example). Select the 
Run ... option under the File menu in Program Manager and type: a: \setup. 
Then choose the OK button. 

2. Continue to insert the remaining diskettes when prompted. 

3. At this point, Setup will start Custom. The Custom application guides you through 
a customized configuration portion of your installation with a short series of dialog 
boxes, prompting you to make selections. 

Note that you will not be prompted for setting domain servers and entries for Host 
Table. You must manually define these names for name resolving. 

4. Select the Save option from the File menu and exit the Custom application. 

5. At the prompt, remove all diskettes and choose the OK button to reboot. 

Upgrade Installation 

To upgrade from a previous NetManage installation, start Windows in enhanced mode: 

Note: If you have ChameleonNFS version 3.11, make sure that you do not have 
PROTMAN.DOS and NETMANAG.DOS drivers loaded in CONFIG.SYS. In 
addition, NETBIND and ODINSUP should be removed from the 
AUTOEXEC.BAT file. 

1. Quit all Chameleon applications and any other TCP/IP applications. 

2. To close the NEWT application: 

• Choose the Network icon from the Control Panel icon. 

• Select NetManage ChameleonNFS (all versions) from the list of networks and 
choose the Remove ... button. The NEWT icon will disappear from your 
screen. 

3. Insert the NFS diskette in the drive of your choice (a:\ in this example). Select the 
Run ... option under the File menu in Program Manager and type: a: \setup. 
Then choose the OK button. 

4. Continue to insert the remaining diskettes when prompted. 

5. At the prompt, remove all diskettes and choose the OK button to reboot. 
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6. In case NFS was not installed or was installed improperly, do the following: 

• Choose the Network icon from the Control Panel icon. 

• Select the NetManage ChameleonNFS (all versions) from the list and choose 
the Install ... button. This network is added to the list of Installed Networks. 
You need to make this network your default network. 

• Choose the OK button. The NEWT icon will appear on your screen. 

The following files will be modified: 

• NET.CFG 

• AUTOEXEC.BAT 

• WIN.INI 

• SYSTEM.INI 

Verifying the Changed Files 

The automated Install program generally makes all the necessary modifications. If you 
experience any problems with these modifications, check these files as follows: 

The ChameleonNFS installation will add more settings to the NET.CFG file. The order 
of Frame and Protocol statements is important. 

Please refer to the Ethernet and IBM Token Ring examples below. 

NET.CFG 

File Name: #Ethernet Adapter 

Link Driver 3C509 
Frame Ethernet_802.3 
Frame Ethernet 802.2 
Frame Ethernet_SNAP 
Frame Ethernet_II 
Protocol RARP 8035 ethernet ii 
Protocol ARP 806 ethernet ii 
Protocol IP 800 ethernet_ii 

#IBM Token Ring Adapter 
Link Driver TOKEN 
Frame TOKEN-RING 
Frame TOKEN-RING_SNAP 
Protocol IPX EO TOKEN-RING 
Protocol IP 800 TOKEN-RING_SNAP 
Protocol ARP 806 TOKEN-RING_SNAP 
Protocol RARP 8035 TOKEN-RING_SNAP 

The installation of ChameleonNFS will add the NMODI driver to the 
AUTOEXEC.BAT file. This driver allows ChameleonNFS to run on top of OD!. 
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File Name: AUTOEXEC.BAT 

Modifications: 

• Adds nmodi 

• Adds netmanag to Path 

Example: 

@ECHO OFF 
PATH C:\NETMANAG;C:\WINDOWS;C:\DOS;C:\ODI 
PROMPT=$p$g 
c:\odi\lsl 
c:\odi\3c509 
c : \ odi \ ipxodi 

<=== ODI driver for your Network Card 

c:\netmanag\nmodi 
c: \odi \netx 

<=== Added by the Install program 

File Name: CONFIG.SYS 

Modifications: None 

File Name: WIN.INI 

Modifications: Adds [TCPIP] section 

Example: 

[TCPIP] 
ID=XXX ... (your encrypted serial number) 
FILE=C:\NETMANAG\TCPIP.CFG 

Note: You should make a pasted backup copy of [TCPIP] for possible future 
troubleshooting. 

File Name: SYSTEM.INI 

Modifications: Makes the following changes: 

• Uses MULT46.DRV as primary network driver 

• Updates boot description 

• Adds nmredir.386 and nmtcpip.386 in [386Enh] section 

Example: 

[boot] 
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network.drv=C:\NETMANAG\MULT46.DRV 
[boot description] 
network.drv=NetManage ChameleonNFS 

The following lines will be added to the [386Enh] section: 

[386Enh] 
;BEGIN NetManage Modification. 
device=C:\netmanag\nmtcpip.386 
device=c:\netmanag\nmredir.386 
;END NetManage Modification. 

Using a Third-Party TCP/IP Stack 
This section describes how to install ChameleonNFS on Windows for Workgroups with 
the Microsoft TCPIIP or other third-party stack option. If your system has a third-party 
stack, you can install ChameleonNFS with the NetManage stack or the third-party stack. 
However, you cannot run both stacks at the same time. 

If you use any third-party stack, be aware that you will not be able to use the 
Custom, NFS, Ping, and Diagnostic Center applications. This is because these 
applications are directly tied to the NetManage TCPIIP stack. 

New Installation with the Microsoft TCP/IP Stack 

If you want to install ChameleonNFS with the Microsoft TCPIIP stack: 

1. . Insert the NFS diskette in the drive of your choice (a: \ in this example). Select the 
Run ... option under the File menu in the Program Manager and type: a:\setup. 
Then choose the OK button. 

2. A dialog box appears that says: Setup has detected an existing WinSock TCPIIP 
stack that reported the following information: Description, Version, System Status. 
Do you want to keep the existing stack? Choose the Yes button. 

Note: If you choose Yes, you will not be able to use the Custom, NFS, Ping, and 
Diagnostic Center applications. 

3. Insert each diskette when prompted, and when finished choose the Continue button. 
Installation is complete at this time. 

Note: The NetManage WINSOCK.DLL, located in the directory where ChameleonNFS 
is installed, will automatically be renamed to WINSOCK.DL. No changes in the 
SYSTEM.INI file will occur. 
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New Installation Replacing Microsoft Stack with NetManage 
Stack 

If you want to install ChameleonNFS and replace the Microsoft TCP/IP stack with the 
NetManage TCPIIP stack: 

1. Select the Drivers ... button to display the Drivers dialog box. 

2. Select the Microsoft TCPIIP-32 3.11 option and choose the Remove button. 

3. Choose the OK button in the Confirm dialog box. Choose the Close and then the 
OK buttons. 

4. Additional messages appear telling you what files have been modified. Continue to 
choose the OK buttons until the Windows Setup dialog box appears. 

5. Choose the Restart Computer button to reboot your machine. 

6. After your machine has been rebooted, restart Windows. 

7. Run Setup. 

Note: Your SYSTEM.INI and WIN.INI files will automatically be changed by 
Windows for Workgroups when you remove the Microsoft stack. 

New Installation with a Third-Party TCP/IP Stack 

If you want to install ChameleonNFS with a third-party TCPIIP stack other than 
Microsoft TCPIIP stack: 

1. Insert the NFS diskette in the drive of your choice (a: \ in this example). Selectthe 
Run ... option under the File menu in Program Manager and type: a: \setup. 
Then choose the OK button. 

2. Continue to insert the remaining diskettes when prompted. 

Note: Take note of the name of the backup file for SYSTEM.INI because you need 
to rename this backup file to SYSTEM.INI at Step 6. 

3. At this point, Setup will start Custom. A dialog appears prompting you to define an 
interface. Choose the Cancel button. 

4. Close the Custom application. 

5. From the c: \NETMANAG directory (your install directory), rename 
WINSOCK.DLL to WINSOCK.DL. 

6. Rename the backup file (mentioned in Step 2) to SYSTEM.INI. 

406 ChameleonNFS Installation and User's Guide 



All ChameleonNFS applications are now installed and can be run with your third-party 
TCPIIP stack. 

OEM Setup for WFW 
NetManage provides its own OEM (Original Equipment Manufacturer) support. For 
example, you may want to recover your original settings in the Network Setup dialog 
box after you install ChameleonNFS. 

OEM Setup for NDIS 

1. Choose the Network program group and then the Network Setup icon. The 
Network Setup dialog box appears. 

2. Choose the Drivers ... button to display the Network Drivers dialog box. 

3. Choose the Add Protocol... button to display the Add Network Protocol dialog box. 

4. Select the Unlisted or Updated protocol item and choose the OK button. The Install 
Driver dialog box appears. 

5. Select the Browse ... button to select the directory where you installed 
ChameleonNFS (default directory is C:\NETMANAG) and choose the OK button 
to display the Install Driver dialog box. 

6. Choose the OK button to display the Unlisted or Updated Protocol dialog box. The 
NetManage ChameleonNFS network now appears on the Drivers list. 

7. Choose the Close button. The Network dialog box appears. 

8. Choose the OK button. The Network Setup dialog appears and choose the OK 
button again. Additional messages appear telling you what files have been 
modified. Continue to choose the OK buttons until the Network dialog box appears. 

9. Choose the Restart Computer button to reboot your machine. 

10. After your machine has been rebooted, restart Windows. 

Note: The network settings in the SYSTEM.INI file are automatically restored to their 
original settings. 

OEM Setup for 001 

1. Choose the Network program group and then the Network Setup icon. The Novell 
Netware dialog box appears. 

2. Choose IPXODLCOM and LSL.COM (recommended) option and choose the OK 
button. The Network Setup dialog box appears. 

3. Choose the Networks ... button to display the Networks dialog box. 
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4. Select the Other option and scroll to select Unlisted or Updated Network and choose 
the OK button. The Install Driver dialog box appears. 

5. Select the Browse ... button to select the directory where you installed 
ChameleonNFS and choose the OK button. (default directory is C:\NETMANAG). 
The Install Driver dialog box appears. 

6. Choose the OK button. The Unlisted or Updated Additional Network dialog box 
appears. The NetManage NFS Driver is highlighted in the Additional Networks 
list. 

7. Choose the OK button. The Networks dialog box appears. 

8. Choose the OK button. The Network Setup dialog appears and choose OK again. 
Additional messages appear telling you what files have been modified. Continue to 
choose the OK buttons until the Network Setup dialog box appears. 

9. Choose the Restart Computer button to reboot your machine. 

10. After your machine has rebooted, restart Windows. 

Note: The network settings in the SYSTEM.INI file are automatically restored to their 
original settings. 
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Note: This appendix is intended ONLY for users that are using the Open Data-Link 
Interface(ODI) for Windows 3.1 or Windows for Workgroups without 
Workgroups networking. 

Open Data-Link Interface (001) 
This appendix applies to users who are using the Open Data-Link Interface (ODI) for 
Windows 3.1 or Window for Workgroups without Workgroups networking. 

The Open Data-Link interface (ODI) allows multiple network protocols to be used 
concurrently on a LAN adapter in a workstation on the network and is an alternative to 
NDIS. The components of ODI are: 

• Network drivers: Multiple Link Interface Drivers (MLIDs) are device drivers that 
handle the sending and receiving of packets to and from a physical or logical LAN 
media. 

• Link Support Layer (LSL): Novell's LSL handles the communication between 
protocol stacks and the network drivers (MLIDs) 

• Protocol Stacks: Network Layer protocol stacks transmit and receive data over a 
logical or physical network. 

Custom verifies that your system has LSL.COM running during setup time, and if so, 
automatically installs the version of the stack that supports OD!. After ODI is installed 
you can access a Novell Netware server, for example, as well as use Chameleon in 
Windows. 

The three scenarios described in this section regarding ODI installation are: 

• setting ODI manually (first time installation) 

• switching from an NDIS environment to an ODI environment 

• switching from an ODINSUP environment to an ODI environment 

Setting 001 Manually 

Follow this section if you are performing afirst time installation. 

• Follow steps 1 - 10 if you do not have ODI installed on your system and you are 
installing ChameleonNFS (new installation) for the first time. 
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• Follow steps 7 - 10 if you have ODr on your system and are installing 
ChameleonNFS (new installation) for the first time. 

Once your system is configured for ODr drivers, the ChameleonNFS installation 
will load the driver NMODLCOM in the AUTOEXEC.BAT file. This driver allows 
ChameleonNFS to communicate with the ODr drivers. 

001 Online Help File 

Refer to ODr online help for additional information about the NMODr driver. The ODr 
online help file, named ODLHLP, contains the following information: ODr driver 
requirements, a sample NET.CFO, advanced NET.CFO parameters, and troubleshooting 
tips. 

Setting Up Your 001 Environment 

The files mentioned in the following steps are contained on the Novell ODr diskette: 

• LSL.COM 

• LAN Driver for network board (for example, 3C503.COM) 

• protocol stack file (for example, rpXODLCOM) 

Note: Use the latest LSL.COM, rpXODLCOM, and NETX files from Novell before 
setting up your ODr environment. 

1. At the DOS prompt, create a directory named C:\ODL 

2. Copy the LSL.COM, driver (3C503.COM for example), protocol stack files 
(IPXODLCOM), and Netware shell (NETX) to this directory. 

3. Append the following lines to the end of the AUTOEXEC.BAT file: 

C:\ODI\LSL.COM 
C:\ODI\<LAN driver> (for example, 3C503) 

Optionally, you can add the following lines if you want to have the Novell rpx 
protocol stack: 

C:\ODI\IPXODI.COM 
c: \ODI\NETX 

4. Create a NET.CFO file and place it in the C:\ODr directory. Refer to the sample 
file provided at the end of this appendix. 

410 

A NET.CFO file is required to run both NetWare and ChameleonNFS concurrently. 

Caution: You need to know which NET.CFO file is used by the ODr environment 
(LSL). We suggest that you have only one NET.CFO file on your disk. 

To ensure smooth establishment of an ODr environment, refer to your network 
adapter vendor's ODr documentation. 
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5. Reboot your system. 

6. If you are using Novell Netware and loaded Novell ODI drivers, then log onto your 
server using the appropriate account and password, and verify to see if you are 
connected to the server by using the WHO AMI command. 

Running Custom Application 

7. Start Windows. 

8. Install ChameleonNFS (refer to your Quick Install Card). 

You can tell when ODI-based ChameleonNFS is installed on your system by 
viewing the Setup menu on the Custom application. If the Hardware option is 
grayed out, then ODI is installed on your system and has been detected by the 
installation program. 

When you are finished setting up Custom, select the Save option to save your 
configuration. 

9. Custom automatically detects the location of the NET.CFG file and then modifies it. 

If Custom cannot detect the NET.CFG file, a prompt appears asking you to enter its 
path. If you know the file's location, then enter its path and choose the OK button. 

If you do not know the location of the NET.CFG file, then choose the Cancel 
button. Custom will automatically copy NetManage's sample NET.CFG file and 
place it at the root directory of drive C. Custom will also open a Window Help file 
that will give you information about NET.CFG. 

Note: The NET.CFG file that NetManage supplies is only a sample file. Because user 
environments are configured differently, this sample file mayor may not work 
with your configuration. There is an ODI online help file available that contains 
detailed information about the sample NET.CFG file. You can choose to view 
this help file when prompted for it. 

10. Reboot your system. 

Switching from an NOIS Environment to an 001 Environment 

This section applies to users who are switching from an NDIS-based interface to an 
ODI-based interface. This section describes, step-by-step how to: 

• upgrade your ChameleonNFS to version 4.6 

• modify your configuration files in order to switch from an NDIS environment to an 
ODI environment 

Follow these steps: 

1. Start Windows in the Enhanced mode. 
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2. Install ChameleonNFS (upgrade installation) according to the instructions on your 
Quick Install Card. 

3. After completing installation, reboot your system and do the following: 

• Start Windows and then choose the Network icon from the Control Panel icon. 

• Select NetManage ChameleonNFS (all versions) from the list of networks and 
choose the Remove ... button. The NEWT icon will disappear from your screen. 

4. From the CONFIG.SYS file, delete the lines: 

DEVICE=C:\NETMANAG\PROTMAN.DOS /I:C:\NETMANAG 
DEVICE=C:\NETMANAG\ELNKII.DOS 
DEVICE=C:\NETMANAG\NETMANAG.DOS 

(or your card's driver) 

5. Delete this line from the AUTOEXEC.BAT file: 

C:\NETMANAG\NETBIND 

6. At the DOS prompt, create a directory named C:\ODI. 

7. Copy the LSL.COM, Multiple Link Interface Driver (MLID) (3C503.COM for 
example), protocol stack files (lPXODI.COM), and Netware shell (NETX) to this 
directory. 

8. Append the following lines to the end of the AUTOEXEC.BAT file: 

C:\ODI\LSL.COM 
C:\ODI\<LAN driver> (for example, 3C503.COM) 

Optionally, you can add the following lines if you want to have the Novell IPX 
protocol stack: 

C:\ODI\IPXODI.COM 
C: \ODI\NETX 

9. Create a NET.CFG file and place it in the C:\ODI directory. Refer to the sample 
file provided at the end of this chapter. 

A NET.CFG file is required to run both NetWare and ChameleonNFS concurrently. 

Note: Make sure you add C:\ODI to your path statement in your AUTOEXEC.BAT 
file. 

To ensure smooth establishment of an ODI environment, refer to your network 
adapter vendor's ODI documentation. 

10. Reboot your system. 

11. Start Windows from the Program Manager, and select the Run entry from the File 
menu and enter the following: 

C:\NETMANAG\CUSTOM.EXE -0 

12. Custom automatically detects the location of the NET.CFG file and then modifies it. 
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If Custom cannot detect the NET.CFG file a prompt appears asking you to enter its 
path. If you know the file's location, then enter its path and choose the OK button. 

If you do not know the location of the NET.CFG file, then choose the Cancel 
button. Custom will automatically copy NetManage's sample NET.CFG file and 
place it at the root directory of drive C. 

Note: The NET.CFG file that NetManage supplies is only a sample file. Because user 
environments are configured differently, this sample file mayor may not work 
with your configuration. There is an ODI online help file available that contains 
detailed information about the sample NET.CFG file. You can choose to view 
this help file when prompted for it. 

13. Close Custom, reboot your system and do the following: 

• Start Windows and choose the Network icon from the Control Panel icon. 

• Choose the Add» button. The Dialog box expands to include a list of 
available networks. 

• Select NetManage ChameleonNFS (all versions) from the list and choose the 
Install ... button. This network is added to the list of Installed Networks. 

• Choose the OK button. The NEWT icon will appear on your screen. 

Switching from an ODINSUP Environment to an 001 
Environment 

This section applies to users who are switching from an ODINSUP-based interface to an 
ODI-based interface. 

Note: There is no need to keep the ODINSUP configuration with native ODI support. 
You may want to eliminate some extra layers, thus releasing more memory and 
increasing reliability. 

1. Start Windows in the enhanced mode. 

2. Install ChameleonNFS (upgrade installation) according to the instructions on your 
Quick Install Card. 

3. When the installation is complete, delete these lines from the AUTOEXEC.BAT 
file: 

ODINSUP 
NETBIND 

4. From the CONFIG.SYS file, delete the lines: 

DEVICE=C:\NETMANAG\PROTMAN.DOS /I:C:\NETMANAG 
DEVICE=C:\NETMANAG\NETMANAG.DOS 

5. From the Program Manager, select the Run option from the File menu and enter the 
following: 
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C:\NETMANAG\CUSTOM.EXE -0 

6. Reboot your system. 

Sample NET.CFG File 
# # # # # # # # # # # # # # # # # # # # # # # # # # # # 

# net.cfg 
# NetManage, Inc. 

# 

05/11/95 

# This net.cfg file is a working example and tested 
# with NetManage TCPIP protocol stack (nmodi/newt) and # Novell IPX 
protocol stack # (ipxodi/netx) simultaneously. 

# 
# In case a problem occurs: 

# 
# 1. Make sure there's no other net.cfg on your hard 

# 

# disk. 

# 2. In order for nmodi.comto load/run you need at # least the following 
entries in the appropriate LINK # DRIVER section of NET.CFG. 
# Ethernet Adapters: 
# frame ethernet_ii 
# Protocol IP 800 ETHERNET_II 
# Protocol ARP 806 ETHERNET_II 
# Protocol RARP 8035 ETHERNET_II 
# TokenRing Adapters: 
# Frame TOKEN-RING_SNAP 
# Protocol IP 800 TOKEN-RING_SNAP 
# Protocol ARP 806 TOKEN-RING_SNAP 
# Protocol RARP 8035 TOKEN-RING_SNAP 
# 

# Please note that all ethernet sections are similar 
token-ring sections. 
# # # # # # # # # # # # # # # # # # # # # # # # # # # 

Link Support 

Buffers 8 4212 ; for token-ring 
MemPoo14096 
Max Stacks 8 

# 3COM EtherLink III Adapter 
Link Driver 3C509 

Frame ETHERNET_802.3 
Frame ETHERNET_II 
Prbtocol IPX 0 
Protocol IPX 
Protocol IP 
Protocol ARP 

8137 

806 

ETHERNET_802.3 
E'T'HF.RNET_II 
800 ETHERNET_II 
ETHERNET_II 

Protocol RARP 8035 ETHERNET_II 
# INTEL Ether Express Adapter 
Link Driver EXP160DI 

Frame ETHERNET_802.3 
Frame ETHERNET_II 
Protocol IPX 0 
Protocol IPX 8137 

ETHERNET_802.3 

# as well as all 
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Protocol IP 
Protocol ARP 806 
Protocol RARP 8035 

#IBM Token Ring Adapter 
Link Driver TOKEN 

Frame TOKEN-RING 
Frame TOKEN-RING_SNAP 
Protocol IPX EO 
Protocol IP 
Protocol ARP 806 
Protocol RARP 8035 

#IBM LAN Support Program 
Link Driver LANSUP 

Max Frame Size 1514 
Frame TOKEN-RING 
Frame TOKEN-RING_SNAP 
Protocol IPX EO 
Protocol IP 
Protocol ARP 806 
Protocol RARP 8035 

#OLICOM Tken Ring Adapter 
Link Driver OCTOK16 

Frame TOKEN-RING 
Frame TOKEN-RING_SNAP 
Protocol IPX EO 
Protocol IP 800 
Protocol ARP 806 
Protocol RARP 8035 

#Madge Token Ring 
Link Driver MADGEODI 

Frame TOKEN-RING 
Frame TOKEN-RING_SNAP 
Protocol IPX EO 
Protocol IP 
Protocol ARP 806 

800 
ETHERNET_II 
ETHERNET_II 

TOKEN-RING 
800 TOKEN-RING_SNAP 
TOKEN-RING_SNAP 
TOKEN-RING_SNAP 

TOKEN-RING 
800 TOKEN-RING_SNAP 
TOKEN-RING_SNAP 
TOKEN-RING_SNAP 

TOKEN-RING 
TOKEN-RING_SNAP 
TOKEN-RING_SNAP 
TOKEN-RING_SNAP 

TOKEN-RING 
800 TOKEN-RING_SNAP 
TOKEN-RING_SNAP 

Protocol RARP 8035 TOKEN-RING_SNAP 
# eof # # # # # # # # # # # # # # # # # # # # # # # # # # # # # 

ODI Troubleshooting 
Cl Make sure your system is running the latest version LSL and MLID. Usually 

manufacturers of network interface cards have the latest version of available MLID. 

Or, you can download them from Compuserve (GO NOVLIB), or from 
FfP.NOVELL.COM using FIP. 

Cl In case the NMODI driver fails to load, check the following: 

a) Make sure there is no other NET.CFG on your hard disk. 

b) In order for nmodi.com to load/run you need the following entries in the 
appropriate LINK DRIVER section of NET.CFG. 
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Ethernet Adapters: 

frame ethernet_ii 
Protocol IP 
Protocol ARP 806 
Protocol RARP 

TokenRing Adapters 

800 ETHERNET_II 
ETHERNET_II 
8035 ETHERNET_II 

Frame TOKEN-RING_SNAP 
Protocol IP 800 TOKEN-RING_SNAP 
Protocol ARP 806 TOKEN-RING_SNAP 
Protocol RARP 8035 TOKEN-RING_SNAP 

o Please note that all Ethernet Link Driver sections are the same as well as all token­
ring sections, independent of a particular MLID. 

If your network media is Token-Ring and you have more than one ring, you may 
want to put the following line in your AUTOEXEC.BAT file before NMODI: 

C:\ODI\ROUTE BOARD=2 

o The board parameter insures that ROUTE.COM is bound to logical board TOKEN­
RING_SNAP, which handles TCP/IP traffic. Refer to the Novell IPX 
documentation for more information about ROUTE.COM 
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access 

account 

address mask 

ANSI 

API 

application 

ARP 

ASCII 

authenticator 

AUTOEXEC.BAT 

Entry to or communication with a particular object, such as 
an operating system, specific files, or accounts. 

An entity which is established as an authorized user of the 
system. 

A bit mask used to select bits from an IP address for subnet 
addressing. The mask is 32 bits long and selects the network 
portion of the IP address and one or more bits of the local 
portion. 

The American National Standards Institute sets standards for 
the U.S. computer industry. ANSI participates in defining 
network protocol standards. 

Application Program Interface. A standard interface that 
allows upper-layer applications to work with different 
communication protocol stacks. Some of the most commonly 
used ones include NetBIOS, Berkeley Sockets, and Named 
Pipes. 

An application is a computer program that performs a certain 
task. FTP, Telnet, TN3270 are some of the applications 
provided by NetManage. 

Address Resolution Protocol. The TCP/IP protocol used to 
dynamically bind a high-level IP address to a low-level 
physical hardware address. ARP is only across a single 
physical network and is limited to networks that support 
hardware broadcast. 

The American Standard Code for Information Interchange, 
widely accepted code for representing alphanumeric 
information. 

A password or code that verifies the identity of individual 
system or network users. 

A file that resides on all PCs and contains a series of 
commands that are executed when the computer starts up. 
This file includes the path command that points to the 
NETMANAG directory where the applications reside. 
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backup 

Bind 

butTer 

client 

command line 

CONFIG.SYS file 

daemon 

DLL 

default 

device name 

DNS 

domain 
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The process of preserving copies of files on a different drive, 
directory, or media to protect against the destruction or loss 
of the original files. 

The Bind application provides name server functions, such as 
a Domain Name Server (DNS). You can specify multiple 
domains and a list of host names within each domain. (See 
also Domain Name System.) 

A temporary storage area for data during the transfer of that 
data between the computer and a peripheral, or between parts 
of a computer, to prevent loss of information. 

A computer system that uses resources provided by another 
machine on the network. Most of NetManage's applications 
can run as both client and server. 

The entire command string, including the command and any 
parameters or qualifiers that it may have. A command is an 
instruction or request for the system to perform a particular 
action. 

This file resides on all PCs and defines which device drivers 
to install. 

An agent program that runs continuously on a server system 
in a UNIX environment and provides resources to client 
systems on the network. 

Dynamic Link Library. Windows automatically loads the 
applications into memory when required and unloads it when 
space is needed for other applications. The Chameleon 
applications are 100% DLL. 

A value supplied by the system when a user does not specify a 
required command, parameter, or qualifier. 

Identification of a physical device: for example, LPTI for a 
printer. Can also be a logical name that is equated to a 
physical device na..rne. 

Domain Name System. An online distributed database that 
maps machine names into IP addresses. (See also Bind.) 

A named group of machines on the network. A domain name 
consists of a sequence of names (labels) separated by periods 
(dots). 

ChameleonNFS Installation and User's Guide 



driver 

Ethernet 

Ethernet address 

export 

file access 

file server 

Finger 

FTP 

group Id 

HLLAPI 

host 

host table 

ICMP 

A software module that controls an input/output port or 
external device such as a keyboard or a monitor. TCPIIP uses 
a driver to control the network interface cards. 

Ethernet is a type of network that supports high-speed 
communication among systems. 

A six-part hexadecimal number in which a colon separates 
each part (for example, 8:0:20:1:2f:0). This number 
identifies the Ethernet communications board installed in a 
PC and is used to identify the PC as a member of the 
network. 

The process that makes a file available so that other systems 
can access it. 

Allows users to work with a remote file as if the file were 
local. 

A process running on a computer that provides access to files 
on that computer to programs running on remote machines. 

A standard protocol that lists who is currently logged in on 
another host. 

File Transfer Protocol. The FTP application is used to 
provide file transfer services across a wide variety of systems. 
Usually implemented as application-level programs, FTP uses 
the Telnet and TCP protocols. The server side requires a 
client to supply a login identifier and password before it will 
honor requests. 

A unique number associated with each group name on the 
server. 

High-Level Language Application Program Interface, which 
you can use to program in high-level languages such as 
COBOL, Pascal, BASIC, or C. 

Any end-user computer system that connects to a network. 
Hosts range in size from personal computers to 
supercomputers. 

ASCII text file in which each line is an entry consisting of 
one numeric address and one or more names associated with 
that address. 

Internet Control Message Protocol. The ICMP delivers error 
and control messages from hosts to the requesters. An ICMP 
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IP 

IP address 

IPXJlink 

login 

logout 

LPRlLPD 

Mail server 

MID 

MID-II 

mount 

NDIS 
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test can determine whether a destination is reachable and 
responding. 

The TCPIIP standard protocol defined as a unit of 
information passed across the Internet, providing the basis for 
packet delivery service. IP includes the ICMP control and 
error message protocol as an integral part. The entire 
protocol suite is often referred to as TCPIIP because TCP and 
IP are the two most fundamental protocols. 

Internet protocol address. This is a 32-bit address assigned to 
host on a TCPIIP Internet. The IP address has a host 
component and a network component. 

The IPXllink application for NetWare connects your PC 
Novell NetWare LAN through the Network Device Interface 
Specification (NDIS) developed by Microsoft and 3COM. 

To perform a sequence of actions at a terminal that establish 
a user's communication with the operating system and sets up 
default characteristics for the user's terminal session. 

To terminate interactive communication with the operating 
system, and end a terminal session. 

Line Printer Remote/ Line Printer Daemon. An application 
that allows you to print to network printers. 

A host and its associated software that offer electronic mail 
reception and forwarding service. Users may send messages 
to, and receive messages from, any other user in the system. 

Management Information Base. The set of variables that a 
gateway running SNMP maintains. 

An extended management database that contains variables 
not shared by SNMP. 

NFS user command that makes remote file systems and 
resources available to the local PC. 

Network Device Interface Specification. NDIS is used for all 
communication with network adapters. The specification was 
developed by Microsoft and 3COM to provide a common 
programming interface for MAC drivers and transport 
drivers. NDIS works primarily with LAN Manager and 
allows multiple protocol stacks to share a single network 
interface card. 
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NetBIOS 

NETBUI 

NetWare 

network address 

network printing 

NEWT 

Network Basic Input/Output system. It provides a Session 
Layer interface between network applications running on a 
PC and the underlying protocol software of the Transport and 
Network Layers. 

The NetBOIS Extended User Interface. This is the transport 
layer driver frequently used by LAN Manager. 

A network operating system developed by Novell. 

A unique number associated with a host that identifies it to 
other hosts during network transactions. 

Printing to a shared printer locally attached to one of the PCs 
on the network. 

NetManage TCPIIP communication stack for Microsoft 
Windows. NEWT provides users a degree of network access 
previously only available to workstation and mainframe 
users. 

NFS Network File System. A protocol developed by Sun 
Microsystems that uses IP to allow a set of computers to 
access each other's file systems as if they were local. 
Originally designed for UNIX systems, this protocol has been 
implemented on many other operating systems, including 
DOS and Windows. 

NIC Network Information Center. The NIC at SRI in Menlo Park, 
California, assigns IP addresses and network numbers by 
request. The number assigned is appropriate to the number of 
host devices on the network. 

PCNSD authenticator A program that runs continuously and authenticates a user 
name and password before attempting to mount a network 
drive, access files, or print on the network. 

Ping The Packet Internet Groper is a program that is useful for 
testing and debugging networks. It sends an echo packet to 
the specified host, and waits for a response. It reports success 
or failure and statistics about its operation. 

POP Post Office Protocol. This protocol is used by the Mail 
application to provide electronic mail services. 

prompt Word or words used by the system to assist a user's response. 
Such messages generally ask the user to respond by typing 
some information in a supplied field. 
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RAM 

remote 

remote host 

remote printer 

RFC 

router 

RPC 

script 

server 

SMTP 

SNMP 

subnet 

subnet address 

subnet mask 

TCPIIP 

422 

RAM is random access memory. 

Files, devices, and users not attached to your local machine. 

The computer receiving a network command. 

In LPRlLPD, a printer with a special network card, or a PC 
or workstation. 

Request For Comment. The RFC documents describe all 
aspects and issues associated with the Internet protocols. 

A router has two or more network interfaces to different 
networks. The primary function of a router is to direct 
packets between these networks, delivering them to their final 
destination or to another router. When used with TCPIIP, the 
term refers to an IP gateway that routes data using IP 
destination addresses. 

Remote Procedure Call. A mechanism defined by Sun 
Microsystems that provides a standard for initiating and 
controlling processes on remote or distributed computer 
systems. 

A sequence of ASCII text lines stored in a file. 

A computer that provides services to a network. 

Simple Mail Transfer Protocol. A protocol used by the Mail 
application to provide electronic mail services. 

Simple Network Monitoring Protocol. A standard protocol 
used to monitor network activity on "agent" nodes from 
management stations. 

A field used by routers and hosts for routing packages on the 
network. 

An extension for the IP addressing that allows a site to use a 
single IP network address for multiple physical networks. 

Identifies the subnet field of a network address. The subnet 
mask is a 32-bit Internet address written in dotted-decimal 
notation with all the 1 s in the network and subnet portions of 
the address. 

Transmission Control ProtocollInternet Protocol. TCP allows 
a process on one machine to send data to a process on another 
machine using the IP protocol. TCP can be used as a full 
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Telnet 

terminal emulator 

TFTP 

token-ring 

TSR 

userid 

\lsername 

utility 

duplex or one-way simplex connection. 

Provides virtual terminal services for a wide variety of remote 
systems using the Telnet protocol. The application allows a 
user at one site to interact with a remote system at another 
site as if the user's terminal were connected to the remote 
machine. 

A program that makes a PC screen and keyboard act like a 
video display terminal of another computer. 

Trivial File Transfer Protocol. A standard TCP/IP protocol 
that allows simple file transfer to and from a remote system 
without directory or file listing. TFTP is used where FfP is 
not available. 

A type of ring-shaped network that supports high-speed 
communications between computers. A distinguishing 
packet, called a "token," is transferred from machine to 
machine. Only the machine that holds the token can transmit 
the packet. 

Terminate-and Stay-resident. A DOS program that is loaded 
into memory before Windows and stays in memory until the 
machine is rebooted. 

A unique number, created by your system, that is associated 
with each user name on a server system. 

A character string, usually assigned by the system 
administrator that identifies a user on the system. 

A command or operation that works at the level of the 
operating system. 
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.CFG,306 

/usr/spool, 171 

/var/spool, 171 

-/-

-3-

3270 Printer, 131 

3287 printer, 101 

-A-
Access account, 331 

accessing resources 

on FrP, 291 

on Gopher, 291 

on Telnet, 291 

activating a script, 65 

adapters 

Token Ring, 416 

adding text, 274 

address book, 209, 226 

Address Resolution Protocol (ARP), 45 

Advanced 

tabs, 72 

Advanced Options 

TN3270, 105 

Advanced tab, 45 

alternate gateway, 43 

anonymous FrP hosts, 313 

AP A Graphics, 106 

Appending Mail, 214 

Archie, 313 
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default server, 315 

retrieving information, 316 

servers, 313 

starting a search, 313 

ARP, 45 

ARP table, 366 

articles, listing and viewing, 309 

AS400, 115 

ASCII, 179, 192, 194, 196 

ASCII Terminal, 75 

ASCII-EBCDIC translation, 109 

assigning 

exported directories, 162 

Assist menu, 140 

Associate command 

3270 Printer, 133 

Async connection type, 78 

Asynchronous Communication 
Settings, 79 

Asynchronous Connection Type, 78 

attaching a signature, 232 

Attachments, 216 

Attachments, sending, 216 

audio requirements 

for InPerson, 269 

Auto Mode, 99 

Auto Start option, 340 

AUTOEXEC.BAT, 24, 31 

automatic configuration, 334 

Automatic Internet, 331, 332, 334,336 

Autoreconnect, 106 

-8-

Banyan Vines, 30 

baud rate, 88 
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BBS, 11,75 

binary, 179, 192, 194, 196 

Binary Connection 

Serial to TeInet application, 125 

Bind,347 

BINDINGS, 25 

boolean, 143 

BOOTP, 38, 39 

Break Handling 

Serial to Telnet application, 125 

broadcast, 20, 38 

buffer size, 155 

bulletin board service, 75 

-C-

caching documents, 284 

Capture to File, 81 

carriage return, 86 

Carriage-Return padding, 124 

CCITT Group 3 protocol, 325 

Challenge Handshake Authenticator 
Protocol, 65 

ChameleonNFS, 1 

printing to a remote printer, 198 

Changing and Updating Topics, Users, 
and Channels, IRC, 382 

changing passwords in Mail, 233 

CHAP, 65 

choosing 

Internet Service, 331 

clear signal 

CICS, 112 

clearing data 

Telnet and Ascn Terminal, 84 

client, NFS, 150 

column order, changing, 9 

column width, changing, 9 

COM ports, 123 

Command Profiles" 362 
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commands 

Script, 142 

Comments, 143 

community option, 369 

compact mailbox, 234 

completing draft message, 215, 216 

Compressed SLIP Protocol, 51 

Compuserve, 11 

CONFIG.SYS,31 

CONFIG.SYS file, 24 

configuration files, 8, 209 

configuring the Personal Web Server, 
296 

Configuring your Communications 
Program for Serial to Telnet, 126 

Connect command 

3270 Printer, 133 

Connecting to a Host 

TN3270, 102 

TN5250,116 

Connecting to a Modem Server, 130 

Connecting to IRC, 373 

connection profile 

for NewtPROFS, 249 

Telnet and ASCII Terminal, 80 

TN3270, 103 

TN5250, 117 

Connection Profile fields 

TN3270, 104, 118 

connection types 

ASCII Terminal, 75 

Async,75 

Rlogin,75 

contacting NetManage, 11 

Control Mode, 99 

OOIltrolling 

printing, 201 

Conversation Profiles 

creating, 319 
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converting 

files, 157, 173 

Copy and Paste functions, 82 

copying messages to files, 215 

Creating a New Channel, IRC, 377 

creating a script, 146 

creating and routing messages, 212 

creating draft message, 215, 216 

CSLIP,51 

CSLIP setup, 52 

Custom, 16, 17,35,63,64,71 

Custom Terminal feature, 61 

Custom, interface types, 35 

customer support, 11 

-0-

Dead-Lock Timer 

Serial to Telnet application, 125 

default caching behavior, 284 

default gateway, 43 

default print type, 199 

Defense Data Network, 343 

deleting 

exported directories, 163 

deleting mail, 214 

deleting phone messages, 243 

demonstration accounts 

Internet Service Provider, 332 

demos 

Internet Service Provider, 332 

Detect, 90 

Device name 

TN3270, 105 

DHCP, 38, 40 

Diagnostic Center, 371 

Dial field, 78 

Dialer, 63 

dialing parameters, 89 

Dialog, 145 

ChameleonNFS Installation and User's Guide 

dialog box fields, 8 

dialup, 51 

Dial-up Login, 70 

Directory Server, 239 

Disconnecting from IRe, 384 

Disk list, 110 

DLL,2 

DNS, 41 

Document Attributes tab dialog, 290 

Documents for the Web, 299 

domain name, 21 

Domain Name Server (DNS), 41, 347 

double quotes, 144 

downloading articles to local drive, 312 

drawing 

in InPerson, 274 

Dynamic Host Configuration Protocol, 
38,40 

-E­
ECCO Setup option, 229 

echo 

local,77 

Echo mode, 125 

echo reply, 339 

Element Attributes tab dialog, 289 

e-mail,205 

empty trash, 214 

emulated printer buttons, 134 

end-of-line characters, 157 

Entering a Message, IRC, 380 

Error Codes, 143 

error message 

Script, 143 

Serial to Telnet application, 125 

escape sequence 

Telnet, 124 

Ethernet, 17, 35 

Ethernet adapters, 416 
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EthernetJDIX, 45 

EthernetJIEEE, 45 

Event, 145 

existing Internet account, 334 

Exit on Disconnect, 106 

expanded packets, 109 

exported directories 

assigning, 162 

removing, 163 

restricting access, 162 

Extended Attributes, 106 

Extended data stream, 105 

-F-
FAX, 325 

File Conversion, 111 

file transfer options, 109 

File Transfer Protocol (FTP), 175 

files 
converting, 157, 173 
attributes, 156 

manipulating, 155, 173 

file-transfer protocols 

ASCII Terminal, 80 

filing mail, 209 

finger, 341 

flow control, 52, 55, 88 

folders, 209 

folders, Trash, 214 

font size 

Program Symbol Graphics, 106 

forwarding a memo, 243 

forwarding mail, 213 

Frequent Destinations, 45 

FTP, 175 

FTP Server, 189 

Function, 144 
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main, 144 

nesting, 144 

-G-
gateway, 366 

alternate, 43 

default, 43 

Gateway tab, 44 

generate mailbox, 235 

Getting Member Information, IRC, 380 

global variables, 144 

Gopher, 327 

gopher bookmarks, 329 

gopher servers, 329 

Graphics, 106 

graphics files, 325 

graphics options 

TN3270, 106 

group ID (GID), 160 

-H-
hardware, 18 

hardware requirements, 13 

InPerson, 269 

history buffer, 82 

scrolling, 83 

size, 83 

HLLAPI, 102, 112, 116 

HLLAPI short name 

for NewtPROFS, 249 

Hold button 

host 

printer, 134 

operating system, 109 

Talk,320 

host administration option, 367 

Host File Format, 111 

host name, 21 

Talk,320 

TN3270, 102 

TN52570, 116 

host table, 42 
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Hotlist, 286 

hotspots, 108 

HTML, 281,282,295,299 

HTML Editor, 284 

HTML files, 284 

HTTP,295 

Hyperlink,301 

Hypertext, 281 

Hypertext Transport Protocol, 295 

-1-

lAC character 

Telnet escape character, 124 

IBM, 101 

IBM 3270 keyboard, 84, 107 

IBM Office Vision, 115 

ICMP, 339 

icons, 16, 23 

importing files, 275 

IND$FILE, 109 

INETD,48 

initializing name, 151 

inline image, 303 

InPerson, 269 

hardware requirements, 269 

phone book, 271 

software requirements, 269 

starting, 270 

Inquire command, 145 

Installation and Setup, 13 

installing windows for workgroups, 387 

installing with Microsoft stack, 405 

installing with multiple protocols, 27 

installing with NetManage stack, 406 

installing with third-party stack, 405 

Interactive Log Window Feature, 61 

Interface Type option, 55 

International character sets, 115 

Internet access account, 331 
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Internet address, 20, 38 

Internet Control Message Protocol 
(ICMP),339 

Internet Relay Chat, 373 

Internet Service Provider 

choosing, 331 

connecting, 334 

IP address, 23, 38, 43, 102, 116 

available and reserved, 20 

entering, 20 

IP address in SLIP, 69 

IP Configuration tab, 38 

IPIUDP bootstrap protocol, 39 

IRC, 373 

ISDN, 13,35 

ISDN interface, 18 

ISDN.INI, 16, 18 

Itelnet,93 

-K­
Key Mappings, 120 

Telnet and ASCII terminal, 85 

TN3270, 84,107 

keyboard, 85 

-L-
Label,142 

LAN Manager., 24 

LAN support, 28 

license violation, 10 

line feed, 86 

line mode, 77 

Line Printer Daemon (LPD) protocol, 
197 

Line Printer Remote (LPR) protocol, 
197 

list articles, 309 

list box 

connection profile, 80 
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local user name, 78 

logging into Mail, 208 

login 

trouble with, 113 

Login Script, 95 

Logout Script, 95 

loopback, 20, 38 

LPD, 197,203 

LPR,197 

LPR query commands, 202 

LUname, 105 

-M-
Mail 

address book, 226 

advanced options, 222 

deleting, 214 

filing, 209 

folders, 209 

inserting, 225 

personal settings, 209 

replying to and forwarding, 213 

setting preferences, 230 

signatures, 232 

suggestions, 221, 222 

timing parameters, 233 

troubleshooting, 237 

Mail Administration, 234 

Mail and Mail Administration, 205 

Mail setup, 205 

Mail, viewing, 211 

MAIL.CFO, 209, 237 

mapping, 174 

Maximum string length, 144 

member window, 270 

merge two mailboxes, 234 

Method 

dialing, 89 

Microsoft LAN Manager, 27 
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Microsoft Window for Workgroups, 30 

MIME, 205 

MLID, 412, 416 

modem, 89 

model,89 

Modem Server application, 129 

Modem tab, 56 

modems, 129 

modifying document styles, 288 

modifying existing scripts, 67 

monochrome terminal emulation, 115 

More button, 79 

TN3270, 105 

MOSAIC.INI,291 

mount 

network drive, 153 

MultiLAN, 168 

MVLTILAN.DRV 

primary or secondary network, 
392,397 

Multiple Link Interface Driver, 412 

-N-
Name Resolution tab, 41 

Name Resolver, 353 

National Character Set, 87 

navigating the Web, 285 

NCSA MOSAIC.INI file information, 
291 

NDIS, 1,2,24,26,27,387,393,411 

NET.CFO, 22, 25, 410, 412 

NETBIND.COM program, 24 

NETBUI protocol, 27 

NetManage 

phone numbers, 11 

Netscape, 291 

network adapter, 1 

Network Device Interface Specification 
(NDIS),1 
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Network File System Protocol (NFS), 
149 

Network Information Center, 343 

Network Information Service, 21 

network printer, 132 

network printing, 163 

Network Virtual Terminal (NVT) mode 

TN3270, 101 

news articles, reading, 308 

newsgroup types, 305 

newsgroups, subscribing, 307 

newsgroups, unsubscribing, 308 

NEVff,I,26,63,74,340,365 

NEWTCal, 263 

deleting appointments, 266 

modifying appointments, 266 

responding to requests, 266 

scheduling appointments, 264 

setting preferences, 264 

viewing, 264 

NEWTNews, 305 

NewtPROFS, 249 

configuration, 260 

starting, 249 

NEWTScan, 277 

NEVffShooter, 9 

NEWTSound, 337 

NEWTTrace, 371 

NewtView, 325 

NEWTWatch,371 

NFS,149 

mount options, 155 

user list, 160 

NFS client, 150 

NFS Utilities, 173 

Nicknames 

NewtPROFS, 255 

NIS, 21 

NIS domain name, 355 
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NIS map entries, 355 

NIS map entry, 355 

NIS server name, 356 

NIS user list, 161 

NISLookup, 355 

NMODI,415 

NMODI driver, 410 

NMODI.COM,410 

Novell, 30,401 

NRC replacement, 87 

null-modem, 56 

numeric constant, 142 

numeric expressions, 143 

numeric variable, 142 

initial value, 144 

NVTmode,77 

-0-

Obtaining 

NIS user list, 161 

ODI, 1, 13,22,25,409 

ODINSUP,413 

OEM for NDIS, 407 

OEM for ODI, 407 

Offline option, 225 

OLE, 290 

ONC RPCIXDR, 6 

online help 

TN3270, 101 

Open Data-Link Interface, 409 

operating system 

host, 109 

Original Equipment Manufacturer, 407 

overriding default caching behavior, 
285 

overview, 1 

-p-

PAP,64 
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Parameter 

Script, 142 

Password Authentication Protocol, 64 

PC ANSI keyboard, 85 

PC NetTime, 349 

PCCONFIG, 30 

PC-NFSD, 152, 154, 170 

Personal Web Server, 295 

phone book 

InPerson, 271 

phone numbers 

NetManage, 11 

Phonetag, 241 

Ping, 170,237,238,339 

pinging, 339 

pMail,249 

Point to Point Protocol, 51 

POP2, 205, 237 

POP3,205 

port, 113 

Portmapper, 159 

Post Office Protocol, 205 

posting articles, 311 

PostScript format, 200 

PPP, 35,51 

PPP setup, 52 

Preparing your machine, 129 

primary interface, 45 

print 

status, 201 

print file, 136 

Print Mode, 98 

Printer application, 131 

Printer Configurations, 132 

printing 

to a remote network printer, 198 

printing a scanned document, 279 

printing from within an application, 
198 
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printing problems, 167 

printing Web documents, 290 

Program Symbol Graphics, 106 

progress box, 111 

Protocol Manager, 24 

PROTOCOL.lNI, 25, 31 

protocols, 39,45 

Provider 

Internet Service, 331 

PSI, 51 

Quiet, 111 

Quote command 

Archie, 317 

quotes, 144 

RARP, 38,40 

-Q-

-R-

R-Commands, 357 

rcp command, 359 

reading news articles, 308 

Redirecting COMM Ports, 123 

Redirection of COMM Ports 

removing, 126 

Registering, 334 

registration card, 11 

Regular expression, 314 

rem, 143 

remote login, 78 

remote machine, 78 

Remote Monitoring, 371 

remote user name, 78 

removing 

exported directories, 163 

Removing or Banning Users from a 
Channel, IRC, 383 

replying to mail, 213 

Reset key, 113 
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restricting 

exported directories, 162 

Result Code, 143 

Retries 

dialing, 89 

Retrieving Information 

Archie, 316 

retrieving message headers only, 222 

Reverse Address Resolution Protocol, 
38,40 

RFC 1041, 101 

RFC1647,101 

Rlogin,75 

route entries, 73 

route table, 366 

routing hubs, 77 

Routing Slip feature, 212 

RPC-SDK,6 

rsh command, 360 

Rsize, 155 

-5-
saving a scanned document, 278 

scanning a document, 277 

Screen Mode, 98 

script 

definition and components, 141 

syntax, 142 

template, 146 

script components, 141 

Selecting COMM Port Numbers 

Serial to Telnet application, 125 

selecting preferences, 243 

sending draft message, 215, 216 

sending mail, 253 

Serial Line Interface Protocol, 51 

serial number, 10 

Serial Port Diagnostic, 90 

Serial to Telnet 
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application, 123 

server printing, 165 

Service Provider, 331, 334 

Session Manager, 137 

session short name, 102, 116 

Setting IRC Preferences, 377 

setting Mail preferences, 230 

setting preferences, NEWTN ews, 312 

setting up mail, 205 

short cut menus, 287 

signing up 

Internet Service, 331 

Simple Mail Transfer Protocol, 205 

Simplified Mode commands 

VSE,139 

SLIP, 17,35,51 

SLIP interface, 70 

SLIP scripting, 65 

SLIP setup, 52 

SLIPIPPP/CSLIP script example, 65, 
66 

Smart Buttons, 8 

Smart POP, 222, 223 

retreiving message headers, 224 

retrieving entire messages, 225 

retrieving message headers, 223 

SMTP, 205, 237 

SNMP, 365, 366, 371 
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